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Color Your Data
This section introduces BVD:

Introducing BVD 8

Logging Into BVD 9

My Account 10

Get Started 12

Introducing BVD
Data does not have to be big to be confusing. It often comes in different formats or languages, and is
spread over different locations and devices. This makes it all the harder to bring data together into one
view, displaying only the latest andmost important information.

HPE OMi Business Value Dashboard (BVD) brings your data to life. Use BVD to create custom,
flexible dashboards that visualize information in an appealing way and that can be accessed anywhere,
anytime, from any device. Incorporate your own graphics, add color to identify status, and receive real-
time updates—so you always understand the value driven by your IT environment.

BVD, color your data.

Anytime, Anywhere. BVD dashboards are real-time dashboards. You choose how often
you send data to BVD; BVD displays the data with no delay. You decide where you want to
view your dashboards: PC, tablet, or phone. BVD supports themajor browsers. Choose

your favorite!

Simple, Colorful, Flexible. Design your dashboards usingMicrosoft Visio. BVD provides
a Visio stencil with shapes that then later become the widgets in your dashboards. The
shapes include widgets for drawing charts, coloring text or values, displaying information

feeds, web pages (for example, video streams), andmany more. You can of course also style your
dashboards according to your company's style guidelines. BVD provides sample dashboards to help
you get started.
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Connect. Once uploaded to BVD, you connect your widgets to the data. The BVD Manage
Dashboards pagemakes this task simple and efficient. You can set additional widget
options such as rules that determine the visibility and status colors of the widgets; or you

can link widgets to other dashboards to enable drill down.

Integrate. BVD can process any kind of data as long as it is sent in JavaScript Object
Notation (JSON), a language-independent, open data format. The out-of-the-box integration
with OMi facilitates the integration of event and KPI status as well as metrics data.

Operations Connector provides policies that automatically forward data collected from various sources
to BVD. Alternatively, create your own integrations for any data source by writing an adapter for BVD.
The adapter must convert the source data to JSON and send the JSON-enabled data to the BVD data
receiver.

Logging Into BVD
You can access BVD using a supported web browser from any computer with a network connection to
the BVD server. The level of access granted to a user depends on the user's permissions.

For a list of supported browsers, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Tasks

This section includes:

l "How to Log Into BVD" below

l "How to LogOut of BVD" on the next page

How to Log Into BVD

1. In a browser, enter the following URL:

http(s)://<BVD_server>:<port>/login/

where
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<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the BVD server.
In a BVD cluster, <BVD_server> represents the IP address or host name of the load balancer.

<port> is the port assigned to BVD during the configuration. Example:
http://bvd.example.com:12222/login
In a BVD cluster, <port> represents the port that was assigned to the load balancer.

2. Enter your login name and password. Initial access can be gained using the administrator user
name and password as specified during the BVD configuration.

Caution: We recommend that the system superuser change this password upon first login to
prevent unauthorized entry. For details on changing the user password, see "My Account"
below. The login name cannot be changed.

Note: Youwill be temporarily locked out from signing into BVD after five failed attempts to
sign into BVD. When your account is locked you will not be able to sign in, even with the
correct password. The lock lasts for 15minutes and resets automatically.

After you log in, your login name appears on the Personal User Settingsmenu.

How to Log Out of BVD

When you complete your session, it is recommended that you log out to prevent unauthorized entry.

Click Log Out on the Personal User Settingsmenu.

My Account
TheMy Account dialog box enables individual users to change their name and password. In addition,
users can provide their email address.

The changes made here are also applied to the user's configuration in User Management. For details,
see "User Management" on page 89.

To access

Click My Account on the Personal User Settingsmenu.

Installation and Administration Guide
Color Your Data

HPE OMi Business Value Dashboard (10.12) Page 10 of 183



Tasks

How to Update My Account Information

1. In theEmail field, enter your email address.

2. In theName field, type a new display name.

3. Click Change Password and enter the old and the new password.

Note: TheChange Password button is not available for LDAP users.

4. Click Change to save your changes.
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Get Started

Step 1: Before You Begin
1. Make sure Visio is installed on the system where you plan to create dashboards for BVD.

2. Log into BVD:

a. Access BVD at the following URL:

http://<BVD_server>:<port>/login/

Enter your login name and password.

b. Recommended. Open the Personal User Settings > My Accountmenu and specify a
new password.

3. In BVD, open Administration > System Settings, and copy theAPI Key.

This key identifies your BVD instance andmust be included in the data submitted by the data
senders.

Note: The System Settings page is only available to users with administrator privileges.

4. Download the following tools and samples in Administration > Download Tools &
Samples, and install them:

o Visio Stencil (Contains the BVD widgets for Visio.)

o Data Generator Sample (Contains a VBScript and a batch file to send data to the OMi sample
dashboard.)
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Step 2: Try the OMi Sample Dashboard
BVD provides the sample dashboardOMi Event and KPI Status Samples (omi_sample) as well as
a batch and a VBScript file for sending data to the example. By following the steps below, you will
becomemore familiar with the BVD dashboards, sending data to BVD, and connecting the data to
dashboard widgets.

You could also look through the BVD Getting Started dashboards, which are based on theOMi
sample dashboard and guide you through the process of modifying a Visio file, uploading the exported
SVG file to BVD, and then sending data to the dashboard.

1. Run the data generator samplegen.bat after extracting it from samplegen.zip. When prompted,
enter the URL of your data receiver, your API key, and the HTTP proxy and port, if required.

Example

Please enter the data receiver URI, e.g.
https://receiver.coloryourdata.io/: http://bvd.example.com:12224/
Please enter your BVD API Key: 47a648e9065d465012e541288b5a345e
Host name of your HTTP proxy server (leave empty if not required):
httpproxy.example.com
Port name of your HTTP proxy server: 8080
Sending sample data to ...

The batch file generates random values and sends them every two seconds to the sample
dashboard.

2. View theOMi sample dashboard in Dashboards > omi_sample. Take amoment to explore
the information displayed and watch it updating as new data arrives.

3. Configure the omi_sample dashboard in Administration > Manage Dashboards > omi_
sample. Take amoment to look at the properties of the dashboard widgets, the data channels,
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fields, and rules.

The following steps demonstrate to you how BVD maps data to widgets:

a. Edit the text value widget below JBoss Cluster System Performance, and delete the

existing data channel ( omi kpi OprSample IT JBoss Cluster System
Performance).

b. Place the cursor in theData Channel field and type omi. The editor displays a list of all data

channels that match the search string omi. Select omi kpi OprSample IT JBoss Cluster

System Performance again.

c. In theData Field, click the down arrow and select status from the drop-down list. This step
configures the text value widget to retrieve the data from the status field in the connected
data channel.

d. Click Cancel to return to theManage Dashboards page.

For more information on sending data to BVD, see "Example: Sending JSON Data to BVD" on
page 134.

Installation and Administration Guide
Color Your Data

HPE OMi Business Value Dashboard (10.12) Page 14 of 183



Step 3: Send Your Own Data to the Dashboard
Before creating your first BVD dashboard, think about the data you want to send and show. Youmay
have numbers indicating the currently logged-in users of your online banking system, metrics
indicating the response time of your web servers, or measurements of the temperature in your data
centers.

BVD expects to receive your data as HTTP post requests in JavaScript Object Notation (JSON)
format.

The URL should look something like this:

http(s)://<BVD_server>:<port>/api/submit/<API_key>/dims/<dims>

<BVD_server>

The Fully Qualified Domain Name (FQDN) of the BVD server.

<port>

The port assigned to the BVD receiver during the configuration. Default: 12224 (HTTP) or 12225 
(HTTPS).

<API_key>

Identifies your BVD instance. You can find the API key in Administration > System
Settings.

<dims>

The names in your JSON name-value pairs. Select and combine dims that uniquely identify your
data.

For more information on the URL of the BVD data receiver, see "Sending dimensions and tags in the
receiver URL" on page 130.

Example URL:

http://bvd.example.com:12224/api/submit/47a648e9065d465012e541288b5a345e/dim
s/viewName,ciName,kpiName/tags/omi,kpi

Example data channel in BVD:

Tags: omi, kpi

Dims: OprSample (=viewName), Employee Self Service (=CiName), Unassigned Events
(=kpiName)
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Step 4: Design Your Own Dashboard in Visio
1. In Visio, create a new drawing. Drag and drop the BVD shapes to your drawing and then arrange

andmodify them as required.

HPE recommends that you do not change the shape data of the BVD shapes in Visio itself. BVD
enables you to adapt the widgets in the uploaded dashboard, which is faster andmore convenient
( Administration > Manage Dashboards).

For an overview of the available widgets and the associated properties, see "Widgets" on page
139.

2. Save your drawing as an SVG file, making sure that the following Visio settings are selected:

o Save as type: Scalable Vector Graphics (*.svg)

o Select: Include Visio data in the files

o Tip: Press Ctrl+A to select everything in the drawing. This ensures that your entire drawing is
exported and not the currently selected element only.

Alternatively, click theExport Dashboard button in theDashboard ribbon, if you have installed
the BVD Visio Addin.
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Step 5: Upload your Dashboard to BVD

1. In BVD, open Administration > Manage Dashboards and click + Add, select your SVG
file, and then click Upload Dashboard to import it. The BVD dashboard editor opens and
displays your uploaded dashboard.

2. You can change the properties of the dashboard itself (for example, the SVG file associated with
the dashboard, the title, or the background color).

To edit the properties of a widget, click the widget. When you click theData Channel field, a
drop-down list opens showing all data streams that have been received by BVD. The data you
sent in Step 3 should be included in the list. Select it, adjust any of the other properties as
required, and click Save. For more information about the widget properties, see "Widget
Properties" on page 150.

3. By default, newly imported dashboards are visible in theDashboardsmenu. To show or hide a
dashboard, click the Show in Menu/Hide from Menu button.

4. View your dashboard by selecting it in the Dashboardsmenu. Then watch your dashboard
updating as you send data over your data channels.
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Installation and Configuration
This section describes how to install, configure, and update BVD.

You can find information about supported operating systems, databases, browsers, as well as
coexistence in the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Prerequisites 19

Hardware Requirements 20

Network Configuration Requirements 21

Database Requirements 21

User Account Requirements 22

Linux Requirements 22

Sizing and Performance Recommendations 23

Installation 24

Installation Process 25

Preparation 25
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LDAP 45

Database 46

Aging 47

License 47

Summary 48

Apply Configuration 48

Silent Configuration 49

Reconfigure BVD 61

Update 64

Uninstallation 65

Uninstallation on aWindows System 66

Uninstallation on a Linux System 67

Uninstallation of the BVD 10.12 Service Pack 67

Licensing 69

License Installation 71

Updating Operations Bridge Licenses for BVD 72

Additional License Authorizations for Systems Management Center Products 72

High Availability 73

Prerequisites
The hardware, network configuration, database, and installing user requirements are listed in this guide.
For a list of supported platforms, web browsers, databasemanagement systems, visualization tools as
well as coexistence and virtualization information, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

This section includes:

l "Hardware Requirements" on the next page

l "Network Configuration Requirements" on page 21
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l "Database Requirements" on the next page

l "User Account Requirements" on page 22

l "Linux Requirements" on page 22

l "Sizing and Performance Recommendations" on page 23

Hardware Requirements

l Processor. 2 CPU cores minimum, 4 recommended. All CPU cores must run at 2.4 GHz or faster.

In a virtual environment, make sure the number of virtual CPUs is equivalent to 2 (or 4) physical
CPU cores.

l Disk space. 10GB

BVD installs to the following default directories:

Directory Reference in
Documentation Windows Linux

Application folder <BVD_Install_
Dir>

C:\Program Files\Hewlett
Packard Enterprise\BVD\

/opt/HP/BVD

Data folder <BVD_Data_Dir> C:\ProgramData\Hewlett
Packard Enterprise\BVD\

/var/opt/HP/BVD

Shared content
installation folder

C:\Program Files\HP\HP BTO
Software\

/opt/OV

Shared content
data folder

C:\ProgramData\HP\HP BTO
Software\

/var/opt/OV

The default Linux directories cannot be changed during the installation.

l Memory (RAM). 2GB (minimum)

For information about the hardware requirements in large computing environments, see "Sizing and
Performance Recommendations" on page 23.
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Network Configuration Requirements

l IP Address. If the system onwhich you are running BVD supports IPv6, then, by default, only IPv6
addresses will be allowed to access BVD.

If you want BVD to only be accessible via IPv4 instead, manually disable IPv6 on your system. On
Windows, access theNetwork and Sharing Center, click Change adapter settings and disable
Internet Protocol Version 6 (TCP/IPv6) in the properties for the corresponding connection.

l Ports. If you use BVD in a cluster setup, the ports 6379 and 26379 have to be open on the network
interface that is selected during the configuration.

Database Requirements

When configuring BVD, you can choose between an external PostgreSQL database and an embedded
PostgreSQL database.

There are no specific requirements for the embedded PostgreSQL database other thanmaking sure
that youmeet the hardware requirements listed in "Hardware Requirements" on the previous page.
BVD installs and configures the embedded PostgreSQL database instance for you on the BVD server.

The requirements for the external PostgreSQL database are as follows:

l Hardware. For PostgreSQL hardware requirements, see the PostgreSQL documentation available
at:

http://www.postgresql.org/docs/manuals/

l PostgreSQL version. For a list of supported PostgreSQL database versions, see the support
matrix at:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select
Operations Manager i Business Value Dashboard from the product list.

l Installation. For details on the PostgreSQL software installation, see the installation guide in the
documentation for your specific PostgreSQL version.

Caution: Make sure you configure the pg_hba.conf file on the PostgreSQL server to accept
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remote connections. Otherwise, the connection to the PostgreSQL database cannot be
established when configuring BVD.

l Configuration. A database for use by BVD must already be configured. The name of the database
must not be postgres. In addition, the user that accesses the databasemust have permissions to
create tables. If you use BVD in a cluster, every nodemust be able to access the PostgreSQL
database.

For details on connecting BVD to the database, see "Configuration" on page 36.

User Account Requirements

l Windows. You need administrative privileges on the host system onwhich you are installing and
configuring BVD. If you are not logged in with an administrator user account, it does not suffice to
click Run as administrator when running the install script.

l Linux. Youmust use the root user account to install and configure BVD.

Linux Requirements

In a non-root environment, SELinux must be disabled on your system:

1. Edit the configuration file: /etc/selinux/config

2. Disable SELinux: SELINUX=disabled

3. Save the file.
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Sizing and Performance Recommendations

If BVD is deployed in large computing environments, refer to the following recommendations to
estimate the requirements and improve the performance of your BVD system.

l Required number of CPUs. The following recommendations are based on the assumption that
the default settings for theWeb Server Processes andReceiver Processes are used.

On a system with an internal PostgreSQL database and a fast disk (for example SSD), the average
load handled by BVD is 100 msg/sec per CPU core.
For an external PostgreSQL database, the write rate of the database can be a limiting factor.

In order to estimate themsg/sec (messages per second) for your BVD environment, calculate the
following:

Example

The number of channels equals the number of dashboards multiplied by the number of
widgets per dashboard. Themessages per minute equals the number of channels multiplied
by the updates per minute (per widget). Themessages per second equals themessages per
minute divided by 60.

Number of
dashboards

Number of
widgets per
dashboard

Number
of
channels

Updates
per minute

Messages
per
minute

Messages
per
second

100 10 1000 1
update/min

1000
msg/min

16
msg/sec

1000 10 10000 1
update/min

10000
msg/min

160
msg/sec

1000 10 10000 5
updates/min

50000
msg/min

833
msg/sec

1000 20 20000 1
update/min

20000
msg/min

333
msg/sec
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l Required disk space.

On top of the 10GB minimum requirement, additional disk space is required for large environments.
In order to estimate the additional disk space requirements for your BVD environment, calculate the
following:

Example

The example is based on the following assumptions: your BVD environment consists of 100
dashboards, each containing 10 widgets. 500messages per widget are kept in the cache
and the average data sample size is 500 bytes.

If you configure the Aging by Maximum Age instead of Maximum Number, you need to calculate the
average incomingmessage ratemultiplied by the time span for aging.
For example, if the configuredMaximum Age is 1 day and the average incomingmessage rate is 1
message per minute per widget, then roughly 1440messages are stored per widget.

l Required RAM.

HPE recommends 8GB RAM for configurations up to 8 CPUs, and 12GB RAM for larger
environments up to 16 CPUs.

Installation
This section includes:

l "Installation Process" on the next page

l "Preparation" on the next page

l "Installation onWindows Systems" on the next page

l "Installation on Linux Systems" on page 32

l "Silent Installation" on page 34

l "Service Pack Installation" on page 35
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Installation Process

Install BVD 10.12 as follows:

1. Run install.bat (Windows) or install.sh (Linux) to install BVD 10.10. The installation wizard
can also run in silent mode.

2. Install the 10.12 service pack.

Preparation

1. Download the following .zip archive file to the system where you want to install BVD:

HPE_OMi_10.10_BusinessValueDashboard.zip

2. Extract all files from the archives.

3. Change to the directory that contains the BVD installation files:

HPE_OMi_10.10_BusinessValueDashboard

4. Optional for Linux. You can verify that the installation files are original HPE-provided code and
have not beenmanipulated by a third-party by using HPE Public Key and the verification
instructions on the following web site: HPE GPG or RPM Signature Verification

Installation on Windows Systems

1. Make sure no other installations or processes requiringWindows Installer are running.

2. Start the installation by running the following command:

install.bat

The BVD setup begins.

3. Choose the language.

Your installer may offer additional languages. The language that you choose in the language
selection window becomes the language of the installation wizard.
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From the drop-down list, select the language that you want to use in the installation wizard, and
then click OK.

Note: Your selection does not affect the following:

o The language of the configuration wizard (it is determined automatically from the operating
system settings).

o The language used in the BVD console.

4. Read the introduction.

The Introduction (Install) page describes the installation wizard. Familiarize yourself with the
information provided and then click Next.
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5. Review the license agreement.

In the License Agreement page, accept the license agreement and click Next to continue with
the installation. If you decline, the installation cannot proceed.
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6. Specify the installation folders:

o Shared content installation folder (default):

C:\Program Files\HP\HP BTO Software\

o Shared content data folder (default):

C:\ProgramData\HP\HP BTO Software\

o Application folder (default):

C:\Program Files\Hewlett Packard Enterprise\BVD\

Referred to as <BVD_Install_Dir> in this documentation.

o Data folder (default):

C:\ProgramData\Hewlett Packard Enterprise\BVD\

Referred to as <BVD_Data_Dir> in this documentation.

Caution: The installation and data directories must not be the same.
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Note: If you are installing BVD on a system with shared content already installed (for
example, a system with OMi installed), you cannot select folders for shared content.

Click Next.

7. Review the product requirements.

The installation wizard checks that the systemmeets the requirements for installing BVD.
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In theProduct Requirements page, click Next.

Note: If a requirement check fails, review the warningmessage andmake sure the system
meets the product requirements listed in this document. After updating the system resources,
click Previous and thenNext to continue with the installation.

8. Install BVD.

Review the information in thePre-Install Summary page and then click Install to start the
installation.
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9. Review the information in the Installation Complete page, for example by clickingView log file.

When you have finished, click Done to close the installation wizard.
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Installation on Linux Systems

1. Log in to the server as user root.

2. Start the installation by running the following command:

./install.sh

The BVD setup begins.

Tip: To install BVD from the console, run the installation script with the -console option:

./install.sh -console

Alternatively, unset the $DISPLAY shell environment variable, and run the commandwithout
specifying the -console option.

3. Choose the language.
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Your installer may offer additional languages. The language that you choose in the language
selection window becomes the language of the installation wizard.

From the drop-down list, select the language that you want to use in the installation wizard, and
then click OK.

Note: Your selection does not affect the following:

o The language of the configuration wizard (it is determined automatically from the operating
system settings).

o The language used in the BVD console.

4. Read the introduction.

The Introduction (Install) page describes the installation wizard. Familiarize yourself with the
information provided and then click Next.

5. Review the license agreement.

In the License Agreement page, accept the license agreement and click Next to continue with
the installation. If you decline, the installation cannot proceed.

6. Review the product requirements.

The installation wizard checks that the systemmeets the requirements for installing BVD.

In theProduct Requirements page, click Next.

Note: If a requirement check fails, review the warningmessage andmake sure the system
meets the product requirements listed in this document. After updating the system resources,
click Previous and thenNext to continue with the installation.

7. Install BVD.

Review the information in thePre-Install Summary page and then click Install to start the
installation.

8. Review the information in the Installation Complete page, for example by clickingView log file.

When you have finished, click Done to close the installation wizard.

BVD installs to the following default directories:

o Shared content installation folder: /opt/OV

o Shared content data folder: /var/opt/OV

o Application directory: /opt/HP/BVD
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Referred to as <BVD_Install_Dir> in this documentation.

o Data directory: /var/opt/HP/BVD

Referred to as <BVD_Data_Dir> in this documentation.

Silent Installation

The BVD installation wizard can be invoked to run in a silent mode. In this mode, the wizard does not
display a graphical user interface.

1. Create an empty file called ovinstallparams.ini in the same directory as the installation
executable file, for example:

o Windows:

HPE_OMi_10.10_BusinessValueDashboard\Software\Windows\HPEBVD_<version>_
setup.exe
HPE_OMi_10.10_BusinessValueDashboard\Software\Windows\ovinstallparams.ini

o Linux:

HPE_OMi_10.10_BusinessValueDashboard/Software/Linux/HPEBVD_<version>_
setup.bin
HPE_OMi_10.10_BusinessValueDashboard/Software/Linux/ovinstallparams.ini

2. Copy the following section to the .ini file on the BVD server:

[installer.properties]
setup=HPEBVD

3. Windows only. To change the default installation directories, add the following lines at the end of
the file:

installDir=<SharedComponentsBinaryFilesDirectory>
dataDir=<SharedComponentsDataDirectory>
prodInstallDir=<BVDBinaryFilesDirectory>
prodDataDir=<BVDDataDirectory>

Note: The first two lines apply to the HPE shared data (shared components), and the last two
lines apply to BVD.

4. Run the installation wizard silently by starting the setup file with the -silent option:
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Windows: HPE_OMi_10.10_BusinessValueDashboard\install.bat -silent

Linux: HPE_OMi_10.10_BusinessValueDashboard/install.sh -silent

Service Pack Installation

After the installation and before you configure BVD, install the 10.12 service pack that is available from
Software Support Online.

Preparation

To install the service pack, prepare the following:

1. Depending on your operating system, access the Software Support Online website that contains
the service pack:

BVD 10.12 Service Pack forWindows

BVD 10.12 Service Pack for Linux

2. Download the .zip file OMI_00157.zip (Windows) or OMI_00158.zip (Linux).

3. Extract all files from the archive into the application folder <BVD_Install_Dir>.

Installation

1. Run the service pack installation script:

Windows: <BVD_Install_Dir>\installation\HPE_BVD_1012\scripts\setup.bat -install

Linux: <BVD_Install_Dir>/installation/HPE_BVD_1012/scripts/setup.pl -install

2. Configure BVD as described in "Configuration" on the next page.
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Configuration
This section includes:

Configure BVD 36

Configuration Type 39

Cluster 40

Connection 41

Login 43

Security 44

LDAP 45

Database 46

Aging 47

License 47

Summary 48

Apply Configuration 48

Silent Configuration 49

Reconfigure BVD 61

Configure BVD

1. When configuring BVD for the first time, you need to specify a password for the configuration
wizard. To set the password and start the configuration, run the following command:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat -p <password>

Linux: /opt/HP/BVD/bin/configure.sh -p <password>

Youwill need to enter this password every time you open the configuration wizard.
The passwordmust be at least eight characters long, contain one lower-case and one upper-case
letter, one digit, and one special character. Special characters should be ASCII characters only.

2. In a browser, enter the URL:
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http://localhost:5000

Note: localhost:5000 uses the default port 5000. If this port is already in use, follow the
instructions displayed in the command line to identify the correct URL.

3. Enter the password you previously specified and click Submit.

4. Modify the BVD settings in the configuration wizard. Click Download to download your settings
as configuration file orApply to start the configuration.

The configuration wizard contains steps to configure the configuration type, the cluster
(optionally), connections (the web server, the BVD data receiver, and the TLS usage), login
settings, security, LDAP, the database, data aging, and licensing.

o "Configuration Type" on page 39

o "Cluster" on page 40

o "Connection" on page 41

o "Login" on page 43

o "Security " on page 44

o "LDAP" on page 45

o "Database" on page 46

o "Aging" on page 47

o "License" on page 47

o "Summary" on page 48

5. After you complete the configuration, run the following command to start all BVD and agent
processes:

ovc -start

6. Verify that the BVD processes are running:

ovc -status

The following processes must be running:

bvdcontroller BVD Controller BVD (4284) Running
bvdpg BVD Postgres DB BVD (3508) Running
bvdrc BVD Receiver BVD (2108) Running
bvdredis BVD Redis Server BVD (1880) Running
bvdsentinel BVD Redis Sentinel BVD (5084) Running
bvdws BVD Web Server BVD (4076) Running
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7. Optional. Check the configuration log file at:

Windows: <BVD_Data_Dir>\BVD\log\configserver.log

Linux: /var/opt/HP/BVD/log/configserver.log

8. In a browser, enter the BVD URL:

http(s)://<BVD_server>:<port>/login/

where

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the system onwhich you
configured BVD; <port> is the port assigned to the BVD server during the configuration. Example:
http://localhost:12222/login

9. Enter your login name and password. Initial access can be gained using the administrator user
name and password that you specified during the configuration. See also "Login" on page 43.

10. After you complete the BVD configuration, you can access the configuration wizard again to
reconfigure BVD. Alternatively, you canmodify the bvdconfig.conf file that you were able to
download during the configuration. See also "Reconfigure BVD" on page 61.
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Configuration Type

To decide how BVD will be configured, choose between a single node installation, beginning a new
cluster, and joining an existing cluster.

Note: Youwill not be able to change the configuration type during reconfiguration.

Single Node Installation

Default. Configure a single BVD node. This results in a standalone BVD server, which cannot be
used to start a cluster. You can choose between a custom and express configuration.

Custom Configuration
Default. Displays the complete configuration wizard. You can specify custom values for all BVD
configuration settings.

Express Configuration
Uses default values for all settings to speed up the configuration process. Only the global
password needs to be specified. When this option is chosen, BVD automatically uses an
embedded PostgreSQL database, no HTTPS or LDAP setup, and a 60-day evaluation license.

Begin a New Cluster

Configure BVD to begin a new cluster. A key will be assigned to the cluster which you can use in
order to addmore nodes at a later point in time. The cluster needs an external PostgreSQL
database. To review the cluster constraints, see "Constraints" on page 87.

Join Existing Cluster

Configure BVD to join an existing cluster. You will have to specify the cluster key that was
assigned during the configuration of the first cluster node.

For details onmanaging your cluster after the initial configuration, see "Cluster Management" on page
86.
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Cluster

If you decided to configure BVD to create or join a BVD cluster, specify additional settings for your
BVD setup.

Internal IP Address

The local IP address of the node that is used to create or join the BVD cluster. The cluster node
uses this IP address to communicate with the other nodes. Select the appropriate IP address from
the drop-downmenu, if there aremultiple assigned to your machine.
To enable communication between the nodes, the ports 6379 and 26379 have to be open.

Tip: To get the local IP address, run the command ipconfig onWindows, or ifconfig on
Linux. Alternatively, run nslookup <node host name>.

Cluster Key

Only displayed if you configure BVD to join a cluster. The cluster key that was assigned during the
configuration of the first node. If you did not save the key separately, you can run
configure --getclusterkey on any node that is part of the cluster to get the assigned key. For
details, see "Cluster Key" on page 87.
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Connection

Configure the web server, receiver, and TLS.

Note: HPE recommends to enable TLS and use a trusted certificate for both the web server and
the receiver. If you do not use TLS, the communication between the servers and web browsers is
not secure.

Web Server

HTTP Port

HTTP port of the web server. Uncheck Use HTTPS to configure the web server without TLS.

Default: 12222 (HTTP), 12223 (HTTPS)

Web Server Processes

Number of web server processes running in parallel. Increase or decrease this number to balance
the web and receiver servers according to your usage pattern. For example, if you havemany
viewers but only a small number of data senders, increase the number of web server processes and
decrease the number of receiver processes.

Default: Half of the number of CPUs on the BVD system (1 if it is a single core system)

Header Name

Use if BVD is configured with a load balancer or proxy. The name of the header that is used to get
the IP address of the UI client system. If the specified header is not found, BVD uses the
IP address of the TCP connection. This IP address is used to determine which process of the BVD
web server handles all requests from a certain UI client (sticky session).

Default: x-forwarded-for

Allow to embed BVD in frames

Determines if BVD can be embedded into other web pages as a frame. If checked, the browser
allows framing from other domains.

Receiver

HTTP Port

HTTP port of the receiver. Uncheck Use HTTPS to configure the web server without TLS.

Default: 12224 (HTTP), 12225 (HTTPS)
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Receiver Processes

Number of receiver processes running in parallel. Increase or decrease this number to balance the
web and receiver servers according to your usage pattern. For example, if you havemany viewers
but only a small number of data senders, increase the number of web server processes and
decrease the number of receiver processes.

Default: Half of the number of CPUs on the BVD system (1 if it is a single core system)

TLS Certificate

Click Use HTTPS for the web server, the receiver, or both in order to enable the TLS Certificate
settings.

Note: If BVD is configured with a load balancer or proxy, you can also have TLS terminate at
the load balancer/proxy tominimize the effort of maintaining certificates. In this case,
communication between the load balancer and the server is not encrypted.

Complete the following steps to configure BVD for TLS:

1. Obtain a server certificate from your certificate authority (CA). Make sure the certificate is
issued to the FQDN of your BVD server. BVD supports certificates in PEM or PFX format.

2. Place the certificates in the file system on your BVD server andmake sure the certificates are
readable by theWindows SYSTEM user or, on Linux, by the user under whose account the
BVD processes are running (default: root).

3. Complete the following information in the BVD configuration wizard to define the TLS setup:

Certificate Type

Choose the certificate type. The certificate can either be an X.509 or CA certificate in PEM
or PFX format.

Certificate File

Upload the certificate you obtained from your certificate authority.
Example: certificate.pem

Key File

Upload the private key file of the certificate.
Example: key.pem

Use Passphrase

If the key file is encrypted, click Use passphrase to specify the passphrase.
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Note: Make sure that your system allows connections from the HTTPS ports you
specified (12223 and 12225 by default). Youmight have to add exception rules to your
firewall to allow TCP requests from these ports.

Login

One built-in super-admin user is defined for every installation of BVD. The login and the password for
this account are specified in the Login page of the configuration wizard.

Name

Login name of the built-in BVD super-admin.

The built-in super-admin is not listed among the users in user management. If you have logged in as
the super-admin, you can change the user's information, including password and contact

information, in theMy Account page in the Personal User Settingsmenu.

Default: admin

Note: The login name cannot be changed when reconfiguring BVD.

Password

Password of the built-in super-admin.

Note: BVD enforces a strong password policy. If you are using LDAP andmixed-mode is
switched off, make sure that your specified administrator account in LDAP complies with the
BVD strong password policy. The passwordmust be at least eight characters long, contain one
lower-case and one upper-case letter, one digit, and one special character. Special characters
should be ASCII characters only.
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Security

Make BVD more secure by configuring the values in theSecurity page of the configuration wizard.

Login Delay

Theminimum time interval (in milliseconds) between a user's consecutive logins. Users will not be
able to log in again unless their last login dates back later than the specified login delay. The
maximum are 5000milliseconds.

Default: 2000

Login Attempts Allowed

Number of allowed login attempts before an error message is displayed. After the specified number
of login attempts, the user profile will be locked for as long as specified in theUser lock out time.

Default: 5

Lock Out Time

The length of time (in seconds) for which a user is locked out of BVD if the number of allowed login
attempts is exceeded.

Default: 900

Linux Only: Non-Root User

On Linux, the BVD and associated processes by default run under a non-root user account.

The following processes are affected:

l BVD processes

l Operations Agent core processes (ovbbccb, ovcd, ovconfd)

Note: On Linux servers, non-root users cannot open ports in the range 0 to 1023. Youmust
therefore specify ports above 1023 for the BVD web server.

Alternatively, you can use the Linux setcap utility to set file capabilities that are extended
attributes on the BVD web server process; for example: setcap 'cap_net_bind_service=+ep'
/opt/HP/BVD/node/node

You can change the user account to the root user by unchecking the box Run as non-root user.

User Name
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User account under which the processes will run. BVD will create the user account if it does not yet
exist.

Default: bvd

Group Name

Group account of the user under which the processes will run. BVD will create the group account if
it does not yet exist.

Default: bvd

LDAP

Simplify the user management process for administrators by enabling and configuring LDAP.
Authentication is performed through the LDAP server which stores the user information.

For details on configuring an LDAP server for BVD user authentication, see "LDAP Authentication and
Mappings" on page 97.
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Database

BVD requires a database to store information. You can choose to create a new, embedded database, or
you can connect to an already existing database.

Note: Before connecting to an external PostgreSQL database, make sure the database is
installed as required by BVD. For details, see "Database Requirements" on page 21.

Database Type

Single node installation only. Choose the type of database to be used. BVD clusters can only use an
external PostgreSQL database.

PostgreSQL external: for use with an external PostgreSQL database.

PostgreSQL internal: for use with the embedded PostgreSQL database.

Note: The internal PostgreSQL database cannot be used if another PostgreSQL database is
already running on themachine. Either use the installed PostgreSQL database as an external
database in BVD, or stop the installed PostgreSQL database in order to use BVD’s embedded
PostgreSQL database.

Connection

Specify how to connect to the chosen database type.

Host

External database only. The name of the host machine on which PostgreSQL is installed.

Default: localhost

Database Name

External database only. The name of a PostgreSQL database that already exists. The database
namemust not be postgres.

Default: bvd

Port

The PostgreSQL listening port.

Default: 5432

PostgreSQL Superuser
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Embedded database only. The name and password of a user with administrative permissions on the
embedded PostgreSQL database.

Default: pg_admin

Database User

The name and password of a user that BVD uses to connect to and retrieve data from the BVD
database. The user must have permissions to create tables in the database.

Default: pg_user

Aging

Configure the controller process that scans the database configuration.
By default, up to 500 data records per data channel are stored in the database. You canmodify the
default and adjust additional data aging settings as described in "Data Aging" on page 165.

License

BVD is installed with a 60-day evaluation license. If you have obtained a permanent license, you can
upload the license by clicking theAdd license from file option.

For details on configuring licensing for BVD, see "Licensing" on page 69.
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Summary

Review the configuration settings and confirm your changes in order to start the configuration.

Click on one of the headings (for example Connection) to change any of the entered values. You will be
redirected to the corresponding configuration page. Click Next until you return to the Summary page.

Click Download to download your configuration settings as bvdconfig.conf file. As this file contains
passwords, save it in a secure place and use it if you want to reconfigure BVD silently at another time.

Note: If you configured BVD to start a new cluster, make sure to save the cluster key in a secure
place.

Click Apply to start the configuration.

To change your settings after the initial configuration, see "Reconfigure BVD" on page 61.

Apply Configuration

Attend the BVD configuration based on the settings you reviewed in theSummary page.

After the configuration is finished, click Launch BVD to start BVD right away. Close the configuration
wizard and the Command Prompt.

To reconfigure BVD after the initial configuration, see "Reconfigure BVD" on page 61.
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Silent Configuration

The BVD configuration can be invoked to run in a silent mode. In this mode, youmodify the BVD
settings in a configuration .conf file, then run the BVD configuration tool with the configuration file as
input.

1. Open a command prompt or shell.

2. Log in as user with administrator privileges (for example, root on Linux).

3. Create a copy of the sample configuration .conf file:

Windows: <BVD_Install_Dir>\BVD\bvdconfig_example.conf

Linux: /opt/HP/BVD/bvdconfig_example.conf

4. Modify the BVD settings in your copy of the configuration .conf file.

The configuration file contains settings for clustering, the database, the web server, the data
receiver, TLS usage, license usage, the built-in administrator user, the LDAP configuration, and
data aging.

Cluster Parameters

Complete the following parameters in the [Cluster] section of the BVD configuration file to
define if BVD should be configured as a single node, to start a new cluster or to join an existing
cluster.

For details on how tomanage clusters in BVD, see "Cluster Management" on page 86.

Parameter Description

cluster Set to true to configure BVD to begin a new cluster, or to configure BVD to join an
existing cluster. Set to false to configure a single BVD node.

If you use BVD in a cluster, set the database type parameter to postgres, as only
external databases are supported in cluster setups.

Default: false

key The cluster key that was assigned during the configuration of the first node.
Specify this parameter only to configure BVD to join an existing cluster.
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If you did not save the key separately, you can run configure --getclusterkey
on any node that is part of the cluster to get the assigned key. For details, see
"Cluster Key" on page 87.

Note: Do not specify the cluster key if you want to reconfigure an existing
cluster node.

ipAddress The local IP address of the node that is used to create or join the BVD cluster. The
cluster node uses this IP address to communicate with the other nodes.

Tip: To get the local IP address, run the command ipconfig onWindows, or
ifconfig on Linux. Alternatively, run nslookup <node host name>.

Linux Only. NonRoot Parameters

Prerequisite

In a non-root environment, SELinux must be disabled on your system:

a. Edit the configuration file: /etc/selinux/config

b. Disable SELinux: SELINUX=disabled

c. Save the file.

On Linux, the BVD and associated processes by default run under a non-root user account.
Complete the following parameters in the [NonRoot] section of the BVD configuration file to
change the user account that is associated with BVD and associated processes.

Parameter Description

username User account under which the processes will run. BVD will create the user
account if it does not exist yet. Leave empty to run BVD under root user account.

Default: bvd

group Group account for the user under which BVD will run. BVD will create the group
account if it does not exist yet. Leave empty to run BVD under root group account.

Default: bvd

Database Parameters

Complete the following parameters in the [Database] section of the BVD configuration file to
define how the database will be configured.
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Note: Before connecting to an external PostgreSQL database, make sure the database is
installed as required by BVD. For details, see "Database Requirements" on page 21.

Parameter Description

type The type of database to be used:

postgres: for use with an external PostgreSQL database

internal: for use with the embedded PostgreSQL database

Default: internal

host External database only. The name of the host machine on which PostgreSQL
is installed.

Default: localhost for the embedded database

database External database only. The name of a PostgreSQL that already exists. The
database namemust not be postgres.

Default: bvd for the embedded database

port The PostgreSQL listening port.

Default: 5432

username The name of a user that BVD uses to connect to and retrieve data from the
BVD database. The user must have permissions to create tables in the
database.

Default: pg_user

password The password of the user. This setting is empty by default.

adminuser Embedded database only. The name of a user with administrative
permissions on the embedded PostgreSQL database.

Default: pg_admin

adminpassword Embedded database only. The password of the administrative user. This
setting is empty by default.

Web Server Parameters

Complete the following parameters in the [WebServer] section of the BVD configuration file to
configure the web server.

Parameter Description
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port HTTP port of the web server.

Default: 12222

usessl Enables or disables TLS for the web server. If set to true, youmust
also specify the sslport parameter for the TLS port.

Note: HPE recommends to enable TLS and use a trusted
certificate for both the web server and the receiver.

Default: true

sslport TLS port of the web server.

Default: 12223

wsProcesses Number of web server processes running in parallel. If this number
exceeds the number of themachine's CPUs/cores, this setting will
be ignored and the number of available CPUs/cores is used instead.

Default: 1

allowFrames Determines if BVD can be embedded into other web pages as a
frame. If set to true, the browser allows framing from other domains.

Default: false

stickySessionHeader Optional if BVD is configured with a load balancer or proxy. The
name of the header that is used to get the IP address of the UI client
system. If the specified header is not found, BVD uses the
IP address of the TCP connection. This IP address is used to
determine which process of the BVD web server handles all
requests from a certain UI client (sticky session).

Default: x-forwarded-for

loginDelay Theminimum time interval (in milliseconds) between a user's
consecutive logins. Users will not be able to log in again unless their
last login dates back later than the specified login delay.

Default: 2000

allowedLoginAttempts Number of allowed login attempts before an error message is
displayed. After the specified number of login attempts, the user
profile will be locked for as long as specified in the
userLockOutTime.

Default: 5

userLockOutTime The length of time (in seconds) for which a user is locked out of BVD
if the number of allowed login attempts is exceeded.

Default: 900
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Receiver Parameters

Complete the following parameters in the [Receiver] section of the BVD configuration file to
configure the BVD data receiver.

Parameter Description

port HTTP port of the data receiver.

Default: 12224

usessl Enables or disables TLS for the receiver. If set to true, youmust also specify
the sslport parameter for the TLS port.

Note: HPE recommends to enable TLS and use a trusted certificate for
both the web server and the receiver.

Default: true

sslport TLS port of the receiver.

Default: 12225

rcProcesses Number of receiver processes running in parallel. If this number exceeds the
number of themachine's CPUs/cores, this setting will be ignored and the
number of available CPUs/cores is used instead.

Default: 1

TLS Parameters

You can configure the BVD web server, the BVD receiver, or both to support secure connections
only.

Complete the following steps to configure BVD for TLS:

a. Obtain a server certificate from your certificate authority (CA). Make sure the certificate is
issued to the FQDN of your BVD server. BVD supports certificates in PEM or PFX format.

b. Place the certificates in the file system on your BVD server andmake sure the certificates are
readable by theWindows SYSTEM user or, on Linux, by the user under whose account the
BVD processes are running (default: root).

c. In the [Web Server] and [Receiver] sections, enable TLS by setting usessl to true and
specifying a sslport.

d. Complete the following parameters in the [SSL] section of the BVD configuration file to define
the TLS setup:
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Parameter Description

certificate Specify the file name of the certificate. The certificate must be an X.509 or
CA certificate in PEM or PFX format.

Example: certificate.pem

key Private key of the certificate. 

Example: key.pem

pfx Container file with the certificate, private key, and CA certificates, in PFX
format.

Example: certificate.pfx

passphrase Optional. Passphrase used to encrypt the key or .pfx file.

License Parameter

Complete the following parameter in the [License] section of the BVD configuration file to
configure the license.

For details on configuring licensing for BVD, see "Licensing" on page 69.

Parameter Description

file File name and path to the license file containing the BVD license. Leave empty to
use the 60-day evaluation license.

Administrator Parameters

One built-in super-admin user is defined for every installation of BVD. Complete the following
parameters in the [Administrator] section of the configuration file to specify the account details:

Parameter Description

name Login name of the built-in BVD super-admin.

The built-in super-admin is not listed among the users in user management. If you
have logged in as the super-admin, you can change the user's information,
including password and contact information in theMy Account page in the
Personal User Settingsmenu.

Default: admin
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password Password of the built-in super-admin. This setting is empty by default.

LDAP Parameters

Automatic user creation from LDAP servers andmapping groups in BVD simplifies the user
management process for administrators as authentication is performed through the LDAP server.

For details on LDAP, permissions, and setup workflows, see "LDAP Authentication and
Mappings" on page 97.

In order to configure the connection to the LDAP server silently, complete the following settings in
the [LDAP] section of the configuration file:

Parameter Description

enabled Set to true to enable LDAP authentication; set to false to
disable LDAP authentication. (If the parameter is missing,
LDAP is enabled and youmust complete the following
parameters.)

Default: false

domain Required. The LDAP domain used to uniquely identify the
LDAP server connection.

Example

If you specify emea, users will be able to log in to BVD
in the format emea\janedoe.

Alternatively, users can log in using themail address
format, for example, jane.doe@example.com. In the
case of email addresses, the domain suffix
(example.com) has to be chosen as the unique domain
name.

url Required. The URL to the LDAP server including the port
number. The URL defines whether an LDAP or LDAPS
connection is established.

The required format is: ldap(s)://<LDAP_FQDN>:<port>

LDAP servers typically use port 389 or secure port 636.

If an LDAPS URL is specified, HPE recommends to provide
the server's CA certificates (setting tlsCA).
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Example

ldap://192.0.2.24:389

tlsVerifyServerCertificate Optional with LDAPS only. This parameter is optional for
LDAPS connections to the LDAP server. If set to true or
missing, the LDAP server certificate is verified against the
list of trusted CA certificates specified in tlsCA.

Default: true

tlsCA Required with LDAPS only. This parameter is only required if
tlsVerifyServerCertificate ist set to true. Specify a
comma-separated list of trusted CA certificate files. The
certificate files must be PEM-encoded.

Example

tlsCA=/tmp/ca1_certificate.crt,/tmp/ca2_
certificate.crt

bindDn The Distinguished Name (DN) of a user with search
privileges on the LDAP directory server. Leave this entry
blank for an anonymous user.

Example

bindDn=CN=Administrator,CN=Users,DC=hpe,DC=c
om

bindCredentials The password of the user entitled to search the LDAP server
entities. Leave this entry blank for an anonymous user.

bindProperty Optional. When an LDAP user tries to log on, the search-
entitled user specified in bindDn searches the LDAP server
entities for that user. When found, the user is authenticated
against LDAP based on one of the user's LDAP properties,
by default the dn property. You can use the bindProperty
parameter to specify another user property to use for
authentication (for example, sAMAccountName or email).

Example

bindProperty=dn

searchBase Required. The Distinguished Name (DN) of the LDAP entity
from which you want to start your user search.

Example

searchBase=CN=Users,DC=omi,DC=hpe,DC=com
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searchFilter Required. Enter the relevant parameters to indicate which
attributes are to be included in the user search.

Note:

Youmust use the literal {{username}} to search for the
given login name.

BVD by default uses the ??sub scope; other scopes are
not supported.

Example

searchFilter=(cn={{username}})

searchFilter=(sAMAccountName={{username}})

groupSearchBase Required. The Distinguished Name (DN) of the LDAP entity
from which you want to start your groups search.

Example

groupSearchBase=CN=Groups,DC=hpe,DC=com

groupSearchFilter Required. Enter the relevant parameters to indicate which
attributes are to be included in the groups search.

Note:

o Youmust use the literal {{dn}} to search for group
members with a given distinguished name.

o You can search for groupmembers that are part of
one out of two groups by using nested queries (see
second example).

o BVD does not support dynamic LDAP groups.
Dynamic groups are therefore ignored in groups
search.

Examples

groupSearchFilter=(member={{dn}})

groupSearchFilter=(member=(&
(objectCategory=Person)(userPrincipalName=
{{username}})(|(memberOf=slk-
Admin,OU=Groups,OU=slk-
Acc,DC=slka,DC=slkb,DC=slkc)
(memberOf=cn=slk-Viewer,OU=Groups,OU=slk-
Acc,DC=slka,DC=slkb,DC=slkc)))
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groupDnProperty Optional. By default, the LDAP user property dn is used to
identify users in groups. You can use the groupDnProperty
setting to specify other properties.

Example

groupDnProperty=dn

mixedMode Required. When set to true, both LDAP users and local
users can log into BVD. When set to false, only LDAP users
are able to log in.

Default: true

autoCreateUser Required. When set to true, BVD automatically creates a
user for every LDAP user when the user logs into BVD with
correct credentials for the first time. When set to false, an
LDAP user can only log into BVD when createdmanually in
BVD UserManagement.

Default: true

Aging Parameters

By default, up to 500 data records per data channel are stored in the database. The controller
process scans the database every hour to identify and automatically delete records that exceed
the configuredmaximum or that are older than 100 days.

Complete the following parameters in the [Aging] section of the configuration file to modify the
aging defaults:

Parameter Description

agingInterval Time interval (in minutes) at which the aging process scans the
database to identify and automatically delete data records.

If the parameter is missing or commented out, the aging
process runs every 60minutes by default. The valuemust be an
integer greater than 0.

Default: 60minutes

purgeMoreThan Maximum number of data records stored in the database per
data channel. If this number is exceeded, the oldest records are
deleted by the aging process.

If the parameter is missing or commented out, no records are
deleted based on this criteria. The valuemust be an integer
greater than 0.
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Default: 500

purgeOlderThan Time period (in days) during which data records are kept in the
database. Records older than the configured time period are
automatically deleted by the aging process.

If the parameter is missing or commented out, no records are
deleted based on this criteria. The valuemust be an integer
greater than 0.

Default: 100 days

unusedChannelStorageTime Time period (in days) during which a data channel is available in
the list of data channels in the widget properties. If a data
channel does not receive any data during the configured time
period and the data channel is not associated with a widget, it is
deleted from the data store. If the data channel is associated
with a widget, the channel is not deleted even if the data last
received for the channel is older than the configured time period.

If the parameter is missing or commented out, no records and
channels are deleted based on this criteria. The valuemust be
an integer greater than 0.

Default: 1 day

Note: The aging process cannot identify and automatically delete data records if both
purgeMoreThan and purgeOlderThan aremissing or commented out. The database will
therefore grow with the number of records received.

5. Run the BVD configuration tool by using your configuration .conf file as input:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat -c <file_path>\<config_
file>.conf

Linux: /opt/HP/BVD/bin/configure.sh -c <file_path>/config_file>.conf

6. After the configuration tool completes, verify that the BVD processes are running. Run the
following command:
ovc -status

7. Optional. Check the configuration log file at:

Windows: <BVD_Data_Dir>\BVD\log\configure.log

Linux: /var/opt/HP/BVD/log/configure.log

8. In a browser, enter the BVD URL:
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http(s)://<BVD_server>:<port>/login/

where

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the system onwhich you
configured BVD; <port> is the port assigned to BVD during the configuration. Example:
http://localhost:12222/login

9. Enter your login name and password. Initial access can be gained using the administrator user
name and password that you specified in the configuration .conf file.

10. Store the configuration .conf file in a secure place.

After the BVD configuration completes, the .conf file is only needed if you want to reconfigure
BVD. See also "Reconfigure BVD" on the next page.

Caution: As the .conf file contains passwords in plain text, move it to a secure location
where only authorized users can access it.
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Reconfigure BVD

If — at a later time— youwant to modify any of the configuration settings, you can start the
configuration wizard again (non-silent mode) or you canmodify the configuration .conf file (silent mode).

The following procedures describe reconfiguring BVD that has been configured in a single server setup.
Extra steps are required for the following setups:

l Embedded PostgreSQL database. Before reconfiguring BVD, make sure that there are no
additional connections to the embedded PostgreSQL database except for the connection from
BVD.

Example: If you have any backup tools running that have an open connection to the PostgreSQL
database, reconfiguring BVD will not be possible.

l Clustered BVD setup. Perform the reconfiguration steps on one BVD cluster node first. If the
reconfiguration includes changes to the database credentials, also perform all reconfiguration steps
on all other BVD cluster nodes. If not, restart BVD on all other nodes.

This section includes:

l "Non-silent BVD reconfiguration" below

l "Silent BVD reconfiguration" on the next page

l "Reconfigure external PostgreSQL settings" on page 63

Non-silent BVD reconfiguration

1. If you previously configured BVD by using the configuration wizard, start the configuration wizard
again by running the following command:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat

Linux: /opt/HP/BVD/bin/configure.sh

If you previously configured BVD silently, run the following command to set a password for the
configuration wizard:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat -p <password>

Linux: /opt/HP/BVD/bin/configure.sh -p <password>
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Youwill need to enter this password every time you open the configuration wizard.
The passwordmust be at least eight characters long, contain one lower-case and one upper-case
letter, one digit, and one special character. Special characters should be ASCII characters only.

2. In a browser, enter the URL:

http://localhost:5000

Note: localhost:5000 uses the default port 5000. If this port is already in use, follow the
instructions displayed in the command line to identify the correct URL.

3. Enter the password for the configuration wizard and click Submit.

4. Modify the settings you want to change in the corresponding configuration page, and click Next
until you arrive at theSummary page. Click Download to download your settings as configuration
file orApply to start the configuration.

Note: You do not need to reupload files. If no files are uploaded, the ones submitted in the
previous configuration will be used. This applies to the TLS certificate, the key file, and the
license file.

5. Optional. Check the configuration log file at:

Windows: <BVD_Data_Dir>\BVD\log\configserver.log

Linux: /var/opt/HP/BVD/log/configserver.log

Silent BVD reconfiguration

If you want to reconfigure BVD silently instead, complete the following steps:

1. If you configured BVD silently, modify the configuration .conf file that was used for the previous
configuration.

If you configured BVD by using the configuration wizard, modify the downloaded bvdconfig.conf
file. If you did not download the configuration file before, start the configuration wizard
again, click Next until you arrive at theSummary page and click Download to save andmodify
the bvdconfig.conf file.

Note: To reconfigure a BVD node silently, remove the cluster key in the bvdconfig.conf
file.

2. Run the BVD configuration tool using themodified configuration .conf file as input:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat -c <file_path>\<config_
file>.conf
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Linux: /opt/HP/BVD/bin/configure.sh -c <file_path>/config_file>.conf

3. After the configuration tool completes, verify that the BVD processes are running. Run the
following command:

ovc -status

4. Optional. Check the configuration log file at:

Windows: <BVD_Data_Dir>\BVD\log\configure.log

Linux: /var/opt/HP/BVD/log/configure.log

Reconfigure external PostgreSQL settings

Note: The following section is only relevant for external PostgreSQL databases. Internal
PostgreSQL databases can be reconfigured as described in "Non-silent BVD reconfiguration" on
page 61 or "Silent BVD reconfiguration" on the previous page.

When you reconfigure the database settings of an external PostgreSQL database, additional actions in
BVD may be required.

l If you usually configure BVD by using the configuration wizard, execute the following steps to align
the database settings in BVD with the changes in the database:

a. Stop all BVD processes: ovc -stop BVD

b. Run one or multiple of the following commands, depending on the database changes:

l To create a new database user: configure.[sh|bat] --dbuser <newUser>

l To change the database user password: configure.[sh|bat] --dbpassword
<newPassword>

l Tomove the database to another host: configure.[sh|bat] --dbhost <newHost>

l Tomove the database to another port: configure.[sh|bat] --dbport <newPort>

l To rename the database instance: configure.[sh|bat] --dbname <newDBname>

c. Start all BVD processes: ovc -start BVD

l If you usually configure BVD silently and have an up-to-date configuration file, update the
[Database] section in the bvdconfig.conf file as required, and follow the steps as described in
"Silent BVD reconfiguration" on the previous page.
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Update
You can update BVD 10.10 or 10.11 to BVD 10.12 by installing the service pack that is available from
Software Support Online.

Preparation

To install the service pack, prepare the following:

1. Stop all BVD processes: ovc -stop BVD

2. Depending on your operating system, access the Software Support Online website that contains
the service pack:

BVD 10.12 Service Pack forWindows

BVD 10.12 Service Pack for Linux

3. Download the .zip file OMI_00157.zip (Windows) or OMI_00158.zip (Linux).

4. Extract all files from the archive into the application folder <BVD_Install_Dir>.

Installation

1. Run the service pack installation script:

Windows: <BVD_Install_Dir>\installation\HPE_BVD_1012\scripts\setup.bat -install

Linux: /opt/HP/BVD/installation/HPE_BVD_1012/scripts/setup.pl -install

2. If you update from BVD 10.10. BVD 10.12 includes a new password policy. Edit your previously
used configuration .ini file to follow these requirements for the database and administrator
passwords: passwords must be at least eight characters long, contain one lower-case and one
upper-case letter, one digit, and one special character.

3. Run the configuration tool using your 10.10 configuration .ini file (with changed passwords) or your
10.11 configuration .conf file as input:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat -c <file_path>\<config_file>
Linux: /opt/HP/BVD/bin/configure.sh -c <file_path>/config_file>

4. Verify that the BVD processes are running: ovc -status
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Note: After updating to BVD 10.12, all channel statistics are temporarily lost. The channel
statistics are back once BVD receives new data.

Uninstallation
Uninstall BVD completely by using the installation wizard or uninstall only the BVD 10.12 service pack.

This section includes:

l "Uninstallation on aWindows System" on the next page

l "Uninstallation on a Linux System" on page 67

l "Uninstallation of the BVD 10.12 Service Pack" on page 67
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Uninstallation on a Windows System

1. Navigate to the folder that contains the BVD installation files and run install.bat.

The BVD installation wizard starts.

Alternatively, use theWindows Control Panel to start the installation wizard.

2. In theMaintenance Selection page, click Uninstall and thenNext.

Follow the wizard instructions when prompted.

3. If the following folders have not been removed by the uninstallation, remove themmanually:

o Application folder (default):

C:\Program Files\Hewlett Packard Enterprise\BVD\

o Data folder (default):

C:\ProgramData\Hewlett Packard Enterprise\BVD\

Caution: If BVD was the only HPE Software application on the system, remove the
following folders:

o Shared content installation folder (default):

C:\Program Files\HP\HP BTO Software\

o Shared content data folder (default):

C:\ProgramData\HP\HP BTO Software\

If BVD was not the only HPE Software application on the system, run the following
command:

o C:\Program Files\HP\HP BTO Software\bin\win64 ovconfchg –edit

Remove all configuration sections that start with bvd, for example [bvd.Database].
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Uninstallation on a Linux System

1. Navigate to the folder that contains the BVD installation files and run the following command to
start the installation wizard:

./install.sh

2. In theMaintenance Selection page, click Uninstall and thenNext.

Follow the wizard instructions when prompted.

3. If the following directories have not been removed by the uninstallation, remove themmanually:

o Application directory: /opt/HP/BVD

o Data directory: /var/opt/HP/BVD

Caution: If BVD was the only HPE Software application on the system, remove the
following directories :

o Shared content installation folder: /opt/OV

o Shared content data folder: /var/opt/OV

If BVD was not the only HPE Software application on the system, run the following
command:

o /opt/OV/bin/ovconfchg –edit

Remove all configuration sections that start with bvd, for example [bvd.Database].

Uninstallation of the BVD 10.12 Service Pack

Uninstall only the BVD 10.12 service pack. Uninstalling the BVD10.12 service pack will bring the
system back to the original patch level, whichmay be either 10.10 (unpatched) or 10.11.

On a Windows System:

1. Stop all running BVD processes:

ovc -stop BVD

2. Run the following command in the BVD 10.12 installation directory to deinstall BVD 10.12:
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<BVD_Install_Dir>\installation\HPE_BVD_1012\scripts\setup.bat -remove

3. Steps 3-7 are only required if you are reverting to a 10.10 version of BVD and you do not have
BVD installed on the same system as OMi. If you are reverting to a 10.11 version of BVD, or you
haveOMi installed on the same system as BVD, skip to step 8.

Navigate to the packages folder in the BVD 10.12 installation directory:

cd <BVD_Install_Dir>\installation\HPE_BVD_1012\packages

4. Run the following commands to remove the Agent, JRE and Perl packages that were installed
with BVD 10.12:

ovc -kill
start /wait msiexec /x {2DE17E6C-3742-485C-AB65-1C8DE1270FB5}
ZBIGNORECONDITIONS=TRUE &REM to remove HPOvJREB
start /wait msiexec /x {C1BDEE5D-50A5-4CFB-B66D-9EAB0F81E87E}
ZBIGNORECONDITIONS=TRUE &REM to remove HPOpsAgt
start /wait msiexec /x {031EBAED-86FE-4E5D-BD99-03380B2029F1}
ZBIGNORECONDITIONS=TRUE &REM to remove HPOvPerlA

5. Uninstall the Shared Components package using theWindows Control Panel:

a. Access thePrograms and FeaturesControl Panel Item

b. Right-click HP Shared Component and chooseUninstall

6. Navigate to the packages folder in the BVD 10.10 installation directory:

cd <Install_Files_10.10>\Software\Windows\packages for version 10.10

7. Run the following commands to install the Agent and Shared Component packages for BVD
10.10:

Note: Specify the same paths as defined in the original agent installation if you defined
different paths than the defaults.

msiexec /i HPSharedComp-12.00.078-Win5.2_64-release.msi /qr
msiexec /i HPOvPerlA-05.16.009-Win5.2_64-release.msi /qr
msiexec /i HPOpsAgt-12.00.078-Win5.2_64-release.msi /qr
msiexec /i HPOvJREB-01.08.045-Win5.2_64-release.msi /qr

8. Reconfigure BVD with the 10.10 or 10.11 configuration file or configuration wizard.

On a Linux System:

1. Stop all running BVD processes:

/opt/OV/bin/ovc -stop BVD
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2. Run the following command to deinstall BVD 10.12:

/opt/HP/BVD/installation/HPE_BVD_1012/scripts/setup.pl -remove

3. Steps 3-5 are only required if you are reverting to a 10.10 BVD version. If you are reverting to a
10.11 BVD version, skip to step 6.

Run the following commands to remove the Agent and Shared Component packages that were
installed with BVD 10.12:

/opt/OV/bin/ovc -kill

rpm -e --nodeps HPOvXpl HPOvSecCo HPOvSecCC HPOvPerlA HPOvPerfMI HPOvPerfAgt
HPOvPacc HPOvOpsAgt HPOvJxpl HPOvJsec HPOvJREB HPOvJPacc HPOvJbbc HPOvGlanc
HPOvEaAgt HPOvDepl HPOvCtrl HPOvConf HPOvBbc HPOvAgtLc

4. Navigate to the packages folder in the BVD 10.10 installation directory:

cd <Install_Files_10.10>/Software/Linux/packages

5. Run the following commands to install the Agent and Shared Component packages for BVD
10.10:

rpm -i --replacefiles HPOvXpl-*.rpm HPOvSecCo-*.rpm HPOvSecCC-*.rpm HPOvPerlA-
*.rpm HPOvPerfMI-*.rpm HPOvPerfAgt-*.rpm HPOvPacc-*.rpm HPOvOpsAgt-*.rpm
HPOvJxpl-*.rpm HPOvJsec-*.rpm HPOvJREB-*.rpm HPOvJPacc-*.rpm HPOvJbbc-*.rpm
HPOvGlanc-*.rpm HPOvEaAgt-*.rpm HPOvDepl-*.rpm HPOvCtrl-*.rpm HPOvConf-*.rpm
HPOvBbc-*.rpm HPOvAgtLc-*.rpm

6. In a non-root environment, run the following command to restore the non-root permissions:

/opt/HP/BVD/dashboard/config/tools/configSwitchUser.sh <username> <groupname>

7. Reconfigure BVD with the 10.10 or 10.11 configuration file or configuration wizard.

Licensing
BVD is licensed with the Operations Bridge Premium and Ultimate Edition Suites and, if an OMi license
is purchased as part of the Express Edition Suite, with the BVD AddOn license. For the Premium
and Ultimate Edition Suites, the number of dashboards you are entitled to create depends on the
number of nodes licensed with the Operations Bridge licenses. For the BVD AddOn license, you are
entitled to create a number of additional dashboards. You install your Operations Bridge license using
the BVD configuration wizard as described in "License Installation" on page 71.

If you do not have anOperations Bridge license yet, you can use BVD with the 60-day Evaluation
license, which entitles you to up to 50 dashboards. To use the Evaluation license, click Evaluation for
60 days in the configuration wizard. The Evaluation license cannot be renewed.
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Formore information on licensing in OMi, seeAdministration Guide > Setup and Maintenance >
License Management in the OMi Administration Guide or Online Help.

This section includes:

l "License Installation" on the next page

l "Updating Operations Bridge Licenses for BVD" on page 72

l "Additional License Authorizations for Systems Management Center Products" on page 72
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License Installation

To install the license for BVD, complete the following steps:

1. Obtain the Operations Bridge license file from theOMi administrator or from HPE. For details on
updating existing Operations Bridge licenses, see "Updating Operations Bridge Licenses for BVD"
on the next page.

Place the license file in the file system on your BVD server. The license file has the .dat file name
extension.

2. Start the configuration wizard by running the following command:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat

Linux: /opt/HP/BVD/bin/configure.sh

3. In a browser, enter the URL:
http://localhost:5000

Note: localhost:5000 uses the default port 5000. If this port is already in use, follow the
instructions displayed in the command line to identify the correct URL.

4. Navigate to the step License and click Add license from file.

Browse to select the .dat license file you want to upload.

5. Click Next until you arrive at theSummary page. Review the configuration settings, then click
Apply to save your changes.

If you havemultiple license files, you can accelerate the process of running the configuration wizard to
add each license. Merge the .dat files into one file, then upload that file to BVD:

Windows: copy /y license1.dat + license2.dat + license3.dat licensesMerged.dat

Linux: cat license1.dat license2.dat license3.dat > licensesMerged.dat

BVD posts a license notification when the license has expired or when the number of configured
dashboards exceeds the allowed number.

You can look up license information such as the license expiration date in the Help > About page.
The following license types are displayed:

INSTANT_ON 60-day Evaluation license
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REGULAR Operations Bridge licenses

NO LICENSE Expired 60-day Evaluation license

Tip: After a license update, log out and log in again to see your changes in the Help > About page.

Updating Operations Bridge Licenses for BVD

If you purchased anOperations Bridge license before OMi version 10.10, you need to retrieve and
activate a new, up-to-date license in order to use BVD. To do so, perform the following:

1. Retrieve your up-to-date license in theHPE My Software Updates portal:
https://www.hpe.com/software/updates

2. Activate the license in theHPE Licensing for Software portal: https://h30580.www3.hp.com

3. Install the new license by following the steps in "License Installation" on the previous page.

If you purchased anOMi Event Foundation license, you can continue using your license, but you will
not be able to use BVD. To be entitled to the use of BVD, you can exchange your old license for a new
license in the new Operations Bridge licensing structure. For more information, contact your sales
representative to discuss your options.

Additional License Authorizations for Systems

Management Center Products

For details on the content of the individual Operations Bridge suites, see the Additional License
Authorizations for HPE Systems Management Center software products.

For themost up-to-date version, go to http://support.openview.hp.com/contracts_licensing.jsp. In the
Additional license authorizations for Enterprise Security, Information Management,
IT Management and Vertica software products table cell, click English (.PDF). Download and open
the resulting PDF document and scroll down to theSystems Management Center Products section
to find the suite you would like to learnmore about. Click the number to the right of the product name to
download the corresponding Additional License Authorizations.
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High Availability
You can improve your system availability and
reliability by usingmultiple BVD cluster nodes
and an external load balancer.

Implementing a high availability configuration
means setting up your BVD servers so that
service is continuous despite power outages or
system downtime.

The clustering options in BVD enable you to add
servers as nodes to a cluster. You can scale out
and add nodes as required, while also increasing
your system availability.

The figure describes a BVD high availability
setup with three cluster nodes, all connected to
the same external PostgreSQL database. A load
balancer handles the incoming BVD connections. If one node fails, the load balancer redirects the BVD
connections to the other cluster nodes.

This section includes:

l "Prerequisites" below

l "How to set up high availability for BVD" on the next page

l "High Availability" above

Prerequisites

l External PostgreSQL database. BVD uses an external PostgreSQL database.

l Cluster setup. All BVD servers are part of the same cluster. Different operating systems cannot be
mixed. To review all cluster constraints, see "Constraints" on page 87.

l Load balancer. All connections to BVD are handled by a load balancer. Configure the load balancer
to handle connections from all cluster nodes.
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How to set up high availability for BVD

1. Install BVD on your first server and configure it to start a new cluster. For details, see "Installation"
on page 24 and "Configuration" on page 36.

2. Configure the load balancer for data provider and user access as follows:

o Configure the load balancer for data provider access.
All data providers must be able to access the virtual IP of the load balancer. Use the standard
settings for the load balancer.

o Configure the load balancer for user access.

Use the standard settings for the load balancer, but set the following:

l Persistence. Set persistence to stickiness by session enabled or destination address
affinity (depending on the load balancer). If neither of these options are available and the
choice is between cookie based stickiness and IP based stickiness, then we recommend
trying IP based stickiness. If this is not done properly, youmay experience intermittent
user interface failures.

l If you use the BVD cluster for scaling, configure stickiness by session enabledwith the
cookie BVD-ID for the web server.

3. Install BVD on additional servers. For details, see "Installation" on page 24.

4. Configure BVD on the additional servers to join the existing cluster of the first node.

Tip: Use the same configuration settings that were used to configure the first BVD server.

For details, see "Configuration" on page 36.
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Administration
This section describes the administration areas of BVD.

System Settings 75

DashboardManagement 77

TemplateManager 82

Cluster Management 86

User Management 89

LDAP Authentication andMappings 97

Download Tools and Samples 106

System Settings
The System Settings page displays your API key and enables you to change the look and feel of your
dashboards and BVD using a custom style sheet.

To access

Administration > System Settings

Learn More

API Key

The API key connects your BVD data to your BVD instance. The key must be included in all of you
data streams and ensures that your data arrives in your dashboards.

You can request a new API key, for example if your old key has been compromised. To request a new
key, click Request New API Key in the System Settings page. BVD displays your new key
immediately. Remember to update your data senders to include your new API key.
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Style Customization

You can change the look and feel of BVD, for example, the color of themasthead. To do so, inspect the
HTML element that you want to change, type the new style in theStyle customization field and click
Upload changed style.

See also "Use Custom Fonts in Your Dashboards" below for detailed instructions on how to choose a
web font other thanGoogle Fonts for your dashboards.

Do It Yourself

Use Custom Fonts in Your Dashboards

BVD dashboards by default use fonts served by Google at http://www.google.com/fonts. To use
custom fonts for your dashboards, do the following:

1. Use your preferred fonts in the Visio drawings of your dashboards, open the exported SVG file in a
text editor, and then search for the string font. In SVG files, fonts are declared in CSS definitions
similar to the following:

Take note of the font family name, for example Metric.

2. Make sure your custom fonts are installed on a publicly accessible web server.
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The web server must allow access to the font resources from other sites. To do so, it must include
a properly configured Access-Control-Allow-Origin header in each reply to a font request.

3. Create a custom CSS font definition in BVD:

Open Administration > System Settings and type your CSS definition in theStyle
customization field, then click Upload changed style.

Example

@font-face {
   font-family: "Metric";
   src: url("https://www.example.com/fonts/metric.woff") format("woff");
}

Dashboard Management
TheManage Dashboards page lists all available dashboards, and enables you to upload, delete,
download, edit, or show or hide dashboards in the dashboards menu.

To access

Administration > Manage Dashboards

Learn More

This section includes:

l "Dashboard Icons" on the next page

l "Uploading Dashboards" on the next page

l "Downloading Dashboards" on page 79

l "Categorizing Dashboards" on page 79

l "Changing the Title of a Dashboard" on page 79

l "SelectingWidgets for Editing" on page 80

l "Using Dashboards as Templates" on page 81
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Dashboard Icons

Use these buttons tomanage your dashboards as follows:

+ Upload a dashboard from an SVG file. Themaximum dashboard size is 20MB.

Delete a dashboard from BVD.

Download a dashboard to an SVG file.

Note: The Download button is not available when working with BVD onmobile
devices.

Edit a dashboard in BVD.

Show or hide a dashboard in the Dashboardsmenu. This action does not impact
permissions to view dashboards granted through roles. To change view permissions, see
"User Management" on page 89.

Tip: Onmobile devices, click the buttons twice to trigger their actions.

The following icons notify you of missing or incorrect configurations when editing a dashboard:

Not all required fields of the widget have been completed; for example, the data channel
has not been selected yet. You can save dashboards that have warnings.

The widget configuration contains errors (for example, incorrect color values, incorrect
HTTP protocol in web page widgets, and so on). Youmust first resolve the errors before
the dashboard can be saved.

The widget has unsaved changes.

Uploading Dashboards

You can upload an SVG file as often as you want. Edit the dashboard, and in the dashboard properties

click Replace Dashboard. Themaximum dashboard size is 20MB. If the file already exists, BVD

replaces the previous version of the file with the newer version and opens the associated dashboard for
you to edit. The newer version does not overwrite existing dashboard properties or widgets, only new
widgets are added.

Deleting widgets from an SVG file only deletes the widgets from the dashboard. The configuration of
the deleted widgets remains in the database so that you can easily re-upload a previous version of an
SVG file to reactivate the previously deleted widgets.
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Downloading Dashboards

When you upload an SVG file created from Visio, the SVG file usually does not have any data channels
configured. This task is best done in the BVD Manage Dashboards UI.

To obtain a version of your SVG files with the data channels configured, you can download the

dashboards from BVD by using the Download button in theManage Dashboards UI. The download
creates an SVG file with the original name.

You can then transfer this file to another BVD instance and upload it there, or store it in a safe location
for backup purposes.

Note: The downloaded SVG file does not include the assigned categories.

Categorizing Dashboards

To be able to grant dashboard permissions to a user, a dashboardmust have
one or more categories assigned. Categories are arbitrary text strings that
you enter in the Categories field in the dashboard properties. Once entered, a
category can be selected and added to any dashboard.

When you create a user role, you can assign view or full control permissions
to a dashboard category. This restricts a user's access to dashboards of the
specified category. See also "How to Set Permissions" on page 95.

Changing the Title of a Dashboard

When you upload an SVG file, the file name automatically becomes the title
of the dashboard. This behavior canmake the Dashboardsmenu look
very technical:

Consider changing the title of your dashboards in the dashboard's properties:

Administration > Manage Dashboards > Edit

In the Title field, enter a descriptive name.
Note: The following characters are not allowed in the dashboard title: !
[ ] / \ = + ; ? * % &
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Selecting Widgets for Editing

To edit the properties of a widget, edit the dashboard that contains the widget and then click the widget.
The properties are displayed to the right of the dashboard for you to edit. When done, click Apply or
Save.

If your dashboard contains widgets that are stacked on top of each other so that you cannot access the
ones below, do one of the following:

l Two widgets. If there are only two widgets stacked on top of each other, click the top one once and
once again. The second click selects the one below.

l More than two widgets. If you have a stack of more than two widgets, go the dashboard
properties, and underWidgets click Select a widget for configuration to open a list of available
widgets:

Select the widget you want to edit to access the widget's properties.
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Using Dashboards as Templates

Use existing dashboards as templates in order to createmultiple instances that use the samewidgets
but different data.

Templates consist of the original dashboard and a number of individual instances, which can be viewed

in the Dashboardsmenu.

Follow these steps to convert a dashboard into a template:

1. Access the properties of the dashboard you want to use as a template:

Administration > Manage Dashboards > Edit

2. Click on the dimension that you want to use as a variable for the instances, for example dim.

3. Click Yes in the resulting dialog to open the TemplateManager.

The original dashboard is automatically added as the first instance of the template. For more
information, see "TemplateManager" on the next page.

Installation and Administration Guide
Administration

HPE OMi Business Value Dashboard (10.12) Page 81 of 183



Example

You have a dashboard with a widget that uses the data channel bvd kpi nyc. You have

twomore data channels that, compared to the first data channel, differ only in the dimension
location:

bvd kpi boston

bvd kpi atlanta

Instead of creating a new dashboard for every location, click on the dimension nyc in the

existing dashboard and click Yes in the resulting dialog. This converts the dashboard into a

template using the dimension nyc as variable. The original dashboard is automatically added

as the first instance. Rename the instance and click Save.

After this, create one instance of the template for every location by choosing different values for
the variable location.
This results in three individual dashboard instances. The dashboards show different data for the
widget that is using the data channel.

Template Manager

The Template Manager enables you to edit, download, and delete dashboard templates. You can add
new instances, or edit and delete existing ones.
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To access

Administration > Manage Dashboards

Choose a dashboard, click Edit, then select the dimension that you want to use as a variable for

your instances, for example dim. Click Yes in the resulting dialog.

Alternatively, choose an already created template and click Edit.

Learn More

This section includes:

l "Licensing for Templates and Instances" below

l "Template and Instance Icons" on the next page

Licensing for Templates and Instances

The number of dashboards you are entitled to create depends on your Operations Bridge licenses.

Each instance counts as one dashboard. The template itself is not counted. For more information on
licensing, see "Licensing" on page 69.
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Template and Instance Icons

Use these buttons tomanage your dashboard templates as follows:

Delete the template and all its instances from BVD.

Caution: Deleting the template will also delete all instances of the template. To
only delete a single instance, use the delete button in the Instances pane.

Download the template to an SVG file.

Edit the template.

Use these buttons tomanage your instances as follows:

Add an instance of the template.

Delete an instance of the template. Click undo after the deletion to restore the deleted
instance.

Show or hide the instance in the Dashboardsmenu. This action does not impact
permissions to view dashboards granted through roles. To change view permissions,
see "User Management" on page 89.

Tasks

This section includes:

l "How to Add New Instances" below

l "How to Edit Instances" on the next page

l "How toModify Templates" on page 86

How to Add New Instances

After creating the dashboard template, the original dashboard is automatically added as the first
instance of the template.

Add additional instances by clicking New in themiddle pane. On the right pane, you can edit the title

of the dashboard (recommended), the categories, and variables.

If you do not edit the values of the variables, the widgets will show the default values of the template.

For more information, see "How to Edit Instances" on the next page.
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How to Edit Instances

Click an instance in themiddle pane to open the properties on the right.

Edit any of the following properties:

Title
Recommended. Change the title of the instance in order to differentiate between the similar
dashboards.

Categories
Instances inherit the categories that are assigned to the template, but can also have individual
categories assigned to them. Remove or add new categories to restrict a user's access to
dashboards of a specified category. For more information, see "Categorizing Dashboards" on page
79.

Variables
The Variables section displays the dimensions you selected as variables when creating the
template, and the available values of the dimensions. Change the values to create individual
instances. By default, the placeholder Variables from template indicates that no value is
assigned and the widget shows the default values of the template. To addmore variables, see
"How toModify Templates" on the next page.
If you remove all variables, the instances will be deleted and the template will be converted back
into a dashboard.

You can use variables in URLs and embedded web pages. For more information, see "Web Page
Widgets" on page 150.

Tip: If recently added variables and/or values are not displayed, select another instance in the
right pane, then reselect the instance you want to modify.
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How to Modify Templates

Editing Templates

Click the Edit button in the left pane.

Edit any of the general Dashboard Properties, or select a widget for editing.

To addmore variables to your template, select a widget for editing. Click on the dimensions you want to
use as variables and save the template.

Saving themodified dashboard template will apply these changes to all instances.

Make sure to assign different values of the variables to each instance. If no values are assigned, the
instances will show the default values of the template.

Replacing Templates

You can upload an SVG file as often as you want. Click the Edit button in the left pane, and in the

Dashboard Properties click Replace Dashboard. Upload a new file with the same name.

Alternatively, click + in the Manage Dashboards page and upload a new file with the same name.

You can choose to replace the SVG only or replace both the SVG and the instances:

Click Replace SVG to replace the previous version of the template with the newer version while
preserving the instances. The newer version does not overwrite existing dashboard properties or
widgets, only new widgets are added. The changes of the new dashboard template are applied to all
instances.
Click Replace Template to replace the previous version of the template with the newer version while
removing the previous instances. The newer version overwrites existing dashboard properties and
widgets.

Cluster Management
The cluster options in BVD enable you to scale out and add nodes as required, as well as increase your
system availability. For details on the high availability setup, see "High Availability" on page 73.

The configure command-line interface enables you tomanage your clusters. Run the corresponding
commands to display the cluster key, set a new key, replace an existing key, remove nodes, or list the
nodes that are part of the cluster.
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To access

You can find the BVD configuration tool in the following location:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat

Linux: /opt/HP/BVD/bin/configure.sh

Learn More

This section includes:

l "Constraints" below

l "Cluster Key" below

l "Setting a New Cluster Key" on the next page

l "Listing Cluster Nodes" on the next page

l "Adding Cluster Nodes" on the next page

l "Removing Cluster Nodes" on the next page

l "Re-Adding a Removed Cluster Node" on page 89

Constraints

Before you decide to configure BVD in a cluster, consider the following constraints:

l A cluster consists of aminimum of three nodes. Clusters with two nodes are not supported.

l A cluster node cannot be reconfigured to become a single node.

l HPE recommends to configure nodes in the same cluster similarly, especially CPU and RAM.

l Mixing the operating systems Windows and Linux in a cluster is not supported.

Cluster Key

During the configuration of the first node of a cluster, a key is assigned. This key uniquely identifies the
cluster. The cluster key is stored in the file system on each system, and has to be entered every time a
new node joins the cluster.
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You can get the cluster key of any node by running configure --getclusterkey

Setting a New Cluster Key

You can set a new cluster key, for example if your old key has been compromised. To request and set a
new key, do the following:

1. Run the following command on one of the nodes:

configure --issuenewkey

Take note of the new cluster key.

2. On all remaining nodes, run the following command:

configure --replaceclusterkey <clusterkey>

Replace <clusterkey>with the newly assigned key.

You canmake sure that the new key is set by running configure --getclusterkey.

Listing Cluster Nodes

You can list all nodes that are part of a specific cluster by running the following command:

configure --listnodes

All BVD servers configured for the cluster are displayed.

Adding Cluster Nodes

Add nodes to a cluster to scale your BVD setup as required. You can add nodes either by using the
configuration wizard, as described in "Cluster" on page 40, or silently, as described in "Silent
Configuration" on page 49.

Removing Cluster Nodes

Remove nodes from a cluster to scale your BVD setup as required.

1. Stop the BVD node that you want to remove by running the following command:

Windows: ovc -stop BVD

Linux: /opt/OV/bin/ovc -stop BVD

Note: This stepmay take amoment while the node status in the database is updated. If the
next step fails, allow somemore time for the update to take place before trying again to
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remove the node from the cluster.

2. Remove the node from its cluster by running the following command on any of the oother nodes
(not the node itself):

configure --deletenode <host name>

The BVD node with the specified host name is removed from the cluster. You canmake sure that the
node has been removed by running configure --listnodes.

Re-Adding a Removed Cluster Node

A BVD node that has been removed from a cluster can be re-added to the cluster.

1. Delete the following files:

o <BVD_HOME_DIR>/dashboard/server.properties

o <BVD_DATA_DIR>/config/config.ini

2. Linux non-root environment only. Run the following commands:

/opt/OVbin/ovc –kill

rm -f /var/opt/OV/conf/ctrl/bvd*

3. Run the configuration wizard and choose the option to join an existing cluster. For details, see
"Configuration Type" on page 39.

User Management
Use theUser Management page to create users and groups and to define roles and permissions. To
reduce the effort and complexity involved in configuring roles for individual users in BVD, permissions
are granted only through roles.

You can specify roles either by assigning them to a group (so that all members of the group are
assigned the same roles) or by assigning roles to a user directly. The user and group configuration
depends on the functions the user or group of users fulfill, as well as the tasks that they perform.

For a suggested workflow and overview of the steps involved in setting up users, groups, and roles,
see "Best Practices" on the next page.

For a step-by-step description of the tasks you can perform through user management, see "Tasks" on
page 93.
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To access

Administration > User Management

Learn More

This section includes:

l "Best Practices" below

l "Roles and Permissions" on the next page

l "Permissions for Templates and Instances" on the next page

l "Users andGroups" on page 92

l "Super-Admin User" on page 92

l "LDAP Users" on page 93

Best Practices

Below is a set of planning best-practices and a suggested workflow for setting up user management in
BVD:

1. Before you configure users, groups, and roles, you shouldmap out the required roles and their
relevant permissions, as well as the users and groups you intend to assign the roles to. For
example, enter the following information in an Excel sheet:

a. A list of users who are to access BVD, edit, and create dashboards. Gather appropriate user
details such as user names, logins, and initial passwords. Although not needed to define users,
at this stage it might be useful to also collect user contact information such as email
addresses.

b. If multiple users require similar permissions, create a list of groups, and the users that should
belong to each group.

c. The appropriate permissions for each role. To aid in this process, review the Permissions
Reference section to learn about dashboard categories and resources for which permissions
can be granted. For details, see "Permissions Reference" on page 96.

2. Create roles and assign relevant permissions.
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For step-by-step instructions on how to create and configure a role, see "How to Create Roles" on
page 94.

3. Create groups and grant them the appropriate roles.

For step-by-step instructions on how to create a group, see "How to Create Groups" on page 94.

4. Create users, grant them the appropriate roles and place them in the appropriate groups.

For step-by-step instructions on how to create a user, see "How to Create Users" on page 93.

Roles and Permissions

BVD enables you to fine-tune permissions management by applying permissions within roles.
Permissions enable you to restrict the scope of a role. You can assign roles to users and groups
enabling access to specific areas of BVD.

Permissions consist of resources, for example, Dashboards, to which operations, for exampleView,
are applied.

l When theView operation is one of the resource's available operations and you select one of the
other available operations, theView operation is also automatically selected.

l The Full Control operation automatically includes all operations available on the resource. When
applied, the other operations are automatically selected.

For a list of available resources and descriptions of operations in BVD, see "Permissions Reference"
on page 96.

Permissions for Templates and Instances

For dashboard templates, you can either assignView or Full Control permission for the template
itself, or assign permissions only for specific instances.

This depends on the categories you assign to the template and each instance.

If you grant a user or group Full Control orView permission for a category assigned to the template,
the user or group will have these permissions also for every instance of the template.

If you grant a user or group Full Control orView permission for a category assigned to an instance, the
user will have these permissions only for that instance.

Note that granting a user or group Full Control permission for a category assigned to an instance, but
not for a category assigned to the template itself, has the same effect as granting them View
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permission. Users or groups are only able tomanage the instance if they have Full Control permission
for a category assigned to the template.

For information on how to set permissions, see "How to Set Permissions" on page 95.

Users and Groups

l Groups. Groups makemanaging roles more efficient; instead of assigning roles to each user one at
a time, you can group users who are assigned the same roles into a single unit.

l User Types. BVD supports different user types:

Users with the appropriate dashboard permissions can view, edit, or create dashboards and
instances. They can download tools and samples to aid in the development of dashboards and the

integration of data. Users with edit permissions can view the Error Notifications icon on the
menu bar. This icon is useful when binding dashboards to data sources. Clicking the icon displays
the error list.

Administrator users (users with super-admin permissions) have the following capabilities:

o Full control and view on all dashboards.

o Manage users, groups, and roles, including the creation and deletion of dashboard categories.

o Apply custom style sheets and reset API keys in the BVD system settings.

Super-Admin User

One built-in super-admin user is defined for every installation of BVD. The login and the password for
this account are specified during the BVD configuration.

The built-in super-admin is not listed among the users in user management. If you have logged in as the
super-admin, you can change the user's information, including password and contact information in the

My Account page in the Personal User Settingsmenu.

You can apply Super-Admin permissions to other users in the system. These super-admin users can
bemodified in user management. For information on how to grant super-admin status to a user, see
"How to Create Users" on the next page.

Note: Super-admins have all permissions assigned and are the only user type that can work with
user management and system settings.
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LDAP Users

To obtain more user management capabilities and security, we recommend using external LDAP user
management. You can apply the LDAP User type when creating or editing users tomanually configure
them as LDAP users. LDAP users will be authenticated against the chosen LDAP server. For
information on how to configure BVD to work with LDAP, see "LDAP Authentication andMappings" on
page 97.

Tasks

This section includes:

l "How to Create Users" below

l "How to Create Groups" on the next page

l "How to Create Roles" on the next page

l "How to Set Permissions" on page 95

How to Create Users

1. Click Create New User on the user management screen.

Alternatively, access theManage Users pane and select New User.

2. In the Properties section, enter the required user name, login, password, and optional email.

3. Optional. If LDAP is enabled, you can select the LDAP User check box tomark the user as a
manually-created LDAP user. For information on LDAP, see "LDAP Authentication andMappings"
on page 97.

4. Select the groups the user will be amember of.

5. Assign roles or (optional) set the user as a Super-admin with all permissions assigned. When
finished, click Create User. For information on the Super-admin user type, see "Super-Admin
User" on the previous page.

The user's basic information, as well as groups they belong to and roles assigned and inherited from
groups, now appears on the right of theManage Users pane when selecting the user.
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To delete existing users, selectManage Users, select one or more users you want to delete, and click
the Delete User or Users button.

Tip: In theManage Users pane ( Administration > User Management), you can click the
Deactivate button to apply the Inactive User flag to users who are set to be temporarily inactive,
for example, while the administrator is setting up roles and groups or if the user is on vacation or
leave. Inactive users cannot log on to BVD.

How to Create Groups

1. Click Create New Group on the user management screen.

Alternatively, access theManage Groups pane and select New Group.

2. In the Properties section, enter the required group name and optional description.

3. Optional. If LDAP is enabled, you can search for and select the LDAP groups that aremapped to
the BVD group. For information on LDAP, see "LDAP Authentication andMappings" on page 97.

4. Add groupmembers and assign roles in the relevant sections of the group editor. When finished,
select Create Group.

Tip: You can select multiple users to add to the group by clicking the ... button next to the
Add user... field. TheSelect Users editor opens. Select a single user, and then hold down
theCtrl key while you click other users that you want to select.

When working with BVD on amobile device, make sure to click a user twice to select it.

The group's basic information, including roles assigned, now appears on the right of theManage
Groups pane when selecting the group. You can also navigate between groups in the group's
information pane.

To delete existing groups go to theManage Groups pane, select one or more groups you want to
delete, and click the Delete Group or Groups button.

How to Create Roles

1. Click Create New Role on the user management screen.

Alternatively, access theManage Roles pane and select New Role.

2. In the Properties section, enter the required role name and optional description.

3. InPermissions, you can select the relevant category and set the appropriate permissions by
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checking the related boxes, or use the drop-downmenus on each permission summary.

For a list of permissions and related descriptions see "Permissions Reference" on the next page.

For a detailed task on setting permissions, see "How to Set Permissions" below.

If you have already created users or groups, you can assign them during role creation or editing.
When finished, select Create Role.

To delete existing roles, selectManage Roles, select one or more roles you want to delete, and click
the Delete Role or Roles button.

Note: When there aremore than 1000 users in the system, the user search box is no longer
displayed. Click the ... button to access the user list and search filter dialog box.

How to Set Permissions

In this task, you set or modify the permissions in BVD roles. Users require permissions to view, edit, or
create BVD dashboards, templates, and instances.

1. In theUser Management page or in theManage Roles page, create or edit the role you want to
configure.

2. Scroll to the permissions section in theCreate Role orEdit Role page.

3. ExpandDashboards > Categories and assign an operation to one or more dashboard categories:

o All. To grant permissions to all dashboards and instances regardless of the category, click
View or Full Control forAll.

o Assigned to category. To grant permissions to all dashboards and instances with any
category, click View or Full Control forAssigned to category.

Alternatively, to grant access to individual dashboard categories, select the appropriate
category.

o Not assigned to category. To grant permissions to all dashboards and instances without a
category, click View or Full Control forNot assigned to category.

4. Click Manage Categories to add new categories to the permissions list. You can also delete
categories from the list if they are no longer needed.

Note: Changes to a user account are only fully available after the user whose account was
changed logs in again to BVD.
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Permissions Reference

Dashboards

Categories All Grants view or full control permission for all
dashboards (with or without categories assigned).

Full control onAll grants the following additional
permissions:

l Upload dashboards.

l Convert dashboards into templates.

l Delete dashboards, templates, and instances.

l Create and delete categories, and assign
categories to dashboards and instances.

l Download tools and samples from the
Administrationmenu.

Assigned to
category
<category>

Not assigned to
category

View Grants permission to:

l View dashboards and
instances in the
Dashboardsmenu.

l Make a dashboard the
default dashboard.

Full Control l Edit dashboards in the
Manage Dashboards
page.

l Show or hide
dashboards in the
Dashboardsmenu.

l Download dashboards.

l Convert dashboards
into templates.

l Edit, download, and
delete templates.

l Edit and delete
instances.
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LDAP Authentication and Mappings
Automatic user creation from LDAP servers andmapping groups in BVD simplifies the user
management process for administrators as authentication is performed through the LDAP server.

Learn More

This section includes:

l "LDAP Authentication Overview" below

l "Permissions" on the next page

l "LDAP SetupWorkflows" on the next page

o "Workflow: LDAP User Authentication, Automatic User Creation, Automatic GroupMapping" on
the next page

o "Workflow: LDAP User Authentication Only (No User Creation and NoGroupMapping)" on page
99

o "Workflow: MixedMode Authentication" on page 99

l "Managing Users" on page 100

l "OMi LDAP Properties Comparison" on page 100

LDAP Authentication Overview

You can use an external LDAP server to store user information (user names and passwords) for
authentication purposes, instead of using the internal BVD service. You canmanually create BVD
users and LDAP users, and use LDAP servers to automatically create LDAP users in BVD andmap
LDAP groups to groups in BVD.

For optimal performance, it is recommended that LDAP servers be in the same subnet as the BVD
server.

For optimal security, it is recommended to either configure a TLS connection between the BVD server
and the LDAP server, or to have the BVD server and the LDAP servers on the same secure internal
network segment. Authentication is performed by the LDAP server, and authorization is handled by the
BVD server.
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You configure the LDAP server for authentication and automatic user creation using the BVD
configuration wizard. For details, see "How to Configure the Connection to the LDAP Server" on page
102.

Permissions

BVD users can automatically get all permissions that are assigned to BVD groups when amapping
between the LDAP groups and the BVD groups has been previously established. When the user logs in
the first time, the LDAP group is used to identify themapped BVD group. The user then automatically
gets all permissions that are assigned to the group.

LDAP users who do not yet exist in BVD, are created as BVD users. Their permissions are determined
as follows:

l If the users belong to amapped LDAP group, they automatically get the permissions assigned to
the BVD group that is mapped to their LDAP group, as set in BVD UserManagement.

l If their group is not mapped to a BVD group, or if they do not belong to an LDAP group, they are
created as a BVD user with no groupmapping and therefore no permissions. Login of such users to
BVD is successful but no dashboards are visible in BVD due to themissing permissions.

If users aremoved between LDAP groups mapped to BVD groups, their permissions change according
to the roles assigned to themapped BVD groups.

LDAP Setup Workflows

The following section contains overviews of user management processes when LDAP is enabled:

Workflow: LDAP User Authentication, Automatic User Creation, Automatic Group

Mapping

l The BVD administrator uses the BVD configuration wizard to configure an LDAP server connection
and enable automatic creation of users. In addition, the BVD administrator maps BVD groups to
LDAP groups in BVD UserManagement.

l The BVD user logs on to BVD with their login name or email address and their company password
(defined in the LDAP server). The domain name is the unique identifier of an LDAP connection.

l The BVD server authenticates the user with the LDAP server, creates the user, gets the group
membership from the LDAP server and identifies the corresponding BVD groups that have been
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mapped.

Note: When setting up LDAP configurations in BVD, ensure that no local BVD user exists that
has the same login name as the unique ID attribute (for example, sAMAccountName or email) of an
LDAP user. If such a local user already exists, the LDAP user will not be automatically created
and will not be able to log in to BVD.

Workflow: LDAP User Authentication Only (No User Creation and No Group

Mapping)

l The BVD administrator uses the BVD configuration wizard to configure an LDAP server connection
and to disable automatic creation of users. In addition, no BVD groups aremapped to LDAP groups
in BVD UserManagement.

The BVD administrator creates a new user with the LDAP User check box selected and with the
unique identifier as the login name (or any other unique LDAP ID that has been configured),
manually assigns roles to the user, and places them in groups.

l The LDAP or BVD-LDAP user logs in to BVD with their domain name and/or email address as the
login name and their company password (defined in the LDAP server).

l The BVD server authenticates the user against the LDAP server.

Workflow: Mixed Mode Authentication

l Mixedmode is enabled by default in the BVD configuration wizard

l The BVD administrator configures an LDAP server connection and optionally enables automatic
creation of users.

l A BVD user logs in to BVD. An LDAP user logs in to BVD.

l BVD authenticates the users against LDAP and, if this is not successful, against BVD. With mixed
mode disabled, BVD users that are not flagged as LDAP users are not able to log in to BVD.

Note: Mixedmode authentication can be disabled for hardening purposes in the BVD configuration
wizard, either when configuring BVD for the first time or when reconfiguring BVD. When you
disable mixedmode during the initial configuration of BVD, the built-in super-admin is created as
LDAP user. When you disable mixedmode after the initial configuration, the built-in super-admin is
authenticated against BVD (you canmanually create additional LDAP super-admins).
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When you disable mixedmode after the initial configuration of BVD, the super-admin built into
BVD becomes an LDAP user and the configuration tries to authenticate this user against the
LDAP server. Therefore, youmust make sure that the name and password that are specified for
the Administrator in the configuration wizard exist on the LDAP server; if not, the configuration will
fail. See also "Configuration" on page 36.

Managing Users

To view LDAP users in BVD, click Manage Users on themain BVD UserManagement page.

LDAP users aremarked by the icon.

Matching the Users Search Filter

To log into BVD, an LDAP user must match the values of theRoot Entry for User Search settings
defined in the BVD configuration wizard.

Any new LDAP user who satisfies the users search filter and authenticates successfully with the
LDAP password will be created as a BVD user on first login. Ask your LDAP administrator to help you
narrow down the filter definition so that only appropriate users can gain access to BVD.

Obsolete Users

Users that have been removed from the LDAP server are still displayed as BVD users, even though
they are no longer registered as LDAP users and cannot log in to BVD.

OMi LDAP Properties Comparison

If you configured LDAP in OMi, you will notice there are differences between the LDAP properties in
OMi and BVD. Because BVD and OMi use different libraries, the wording of the properties is not
always the same.

See the following table tomap theOMi LDAP properties to the BVD LDAP properties from the
configuration wizard or the silent configuration file.

OMi LDAP Property BVD Configuration Wizard
BVD Silent
Configuration

LDAP Server URL Combination of the URL and the
Distinguished Name (DN) of the Root
Entry for User Search

Combination of url
and searchBase
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Example
ldap://192.168.
254.69:389/
CN=Users,DC=omi,DC=com

Example

url=ldap://
192.
168.254.69:
389
searchBase=
CN=
Users,DC=om
i,
DC=com

Unique domain LDAP Domain domain

Distinguished Name of Search-
Entitled User

Distinguished Name (DN) of the User
Entitled to Search LDAP

bindDn

Password for Search-
Entitled User

Password of the User Entitled to
Search LDAP

bindCredentials

Users filter Search Filter for the Root Entry for
User Search

searchFilter

Groups base DN Distinguished Name (DN) for the Root
Entry for Group Search

groupSearchBase

Groups search filter Search Filter for the Root Entry for
Group Search

groupSearchFilter

No equivalent in OMi

Note: In most LDAP
environments, these
properties can use the default
value dn.

Identifying Properties for Users and
Groups

For users
bindProperty, for
groups
groupDnProperty

Tasks

This section includes:

l "How to Configure the Connection to the LDAP Server" on the next page

l "How toMapGroups Configured in BVD to Groups Configured on the LDAP Server" on page 105
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How to Configure the Connection to the LDAP Server

You configure the LDAP server for authentication and automatic user creation using the BVD
configuration wizard:

1. Start the configuration wizard by running the following command:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat

Linux: /opt/HP/BVD/bin/configure.sh

2. In a browser, enter the URL:
http://localhost:5000

Note: localhost:5000 uses the default port 5000. If this port is already in use, follow the
instructions displayed in the command line to identify the correct URL.

3. Enter the password for the configuration wizard and click Submit.

4. Navigate to the step LDAP, click Use LDAP and complete the following settings:

LDAP Domain

Specify the LDAP domain used to uniquely identify the LDAP server connection.

Example

If you specify emea, users will be able to log in to BVD in the format emea\janedoe.

Alternatively, users can log in using themail address format, for example,
jane.doe@example.com. In the case of email addresses, the domain suffix
(example.com) has to be chosen as the unique domain name.

URL

The URL to the LDAP server including the port number. The URL defines whether an LDAP or
LDAPS connection is established.

The required format is: ldap(s)://<LDAP_FQDN>:<port>

LDAP servers typically use port 389 or secure port 636.

If an LDAPS URL is specified, provide the server's CA certificates in LDAPS CAs. You can
also choose to use LDAPS without certificates by disablingVerify Server Certificate.

Example

ldap://192.0.2.24:389

Installation and Administration Guide
Administration

HPE OMi Business Value Dashboard (10.12) Page 102 of 183



Verify Server Certificate

The LDAP server certificate is verified against the trusted CA certificates that are uploaded in
LDAPS CAs.

LDAPS CAs

This setting is only required if the secure LDAP (LDAPS) protocol is used for communication
with the LDAP server. Upload trusted CA certificate files. The certificate files must be PEM-
encoded.

Example

/tmp/ca1_certificate.crt

Mixed Mode

When selected, both LDAP users and local users can log into BVD. Otherwise only LDAP
users are able to log in.

Auto Create User

When selected, BVD automatically creates a user for every LDAP user when the user logs into
BVD with correct credentials for the first time. When not selected, an LDAP user can only log
into BVD when createdmanually in BVD UserManagement.

User Entitled to Search LDAP

Define the Distinguished Name (DN) and password of a user with search privileges on the
LDAP directory server.

Note: Some LDAP servers allow anonymous search.

Example

CN=Administrator,CN=Users,DC=hpe,DC=com

Root Entry for User Search

Specify the root entry for your LDAP user search.

Distinguished Name (DN)

The Distinguished Name (DN) of the LDAP entity from which you want to start your user
search.
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Example

CN=Users,DC=omi,DC=hpe,DC=com

Search Filter

Enter the relevant parameters to indicate which attributes are to be included in the user search.

Note:

Youmust use the literal {{username}} to search for the given login name.

BVD by default uses the ??sub scope; other scopes are not supported.

Example

(cn={{username}})

(sAMAccountName={{username}})

Root Entry for Group Search

Specify the root entry for your LDAP group search.

Distinguished Name (DN)

The Distinguished Name (DN) of the LDAP entity from which you want to start your group
search.

Example

groupSearchBase=CN=Groups,DC=hpe,DC=com

Search Filter

Enter the relevant parameters to indicate which attributes are to be included in the group
search.

You can configure the search attribute in the Identifying Properties For Group setting.

Note:

o Youmust use the literal {{dn}} to search for groupmembers with a given
distinguished name.

o You can search for groupmembers that are part of one out of two groups by using
nested queries (see second example).
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o BVD does not support dynamic LDAP groups. Dynamic groups are therefore ignored in
groups search.

Examples

(member={{dn}})

(member=(&(objectCategory=Person)(userPrincipalName={{username}})(|
(memberOf=slk-Admin,OU=Groups,OU=slk-Acc,DC=slka,DC=slkb,DC=slkc)
(memberOf=cn=slk-Viewer,OU=Groups,OU=slk-Acc,DC=slka,DC=slkb,DC=slkc)))

Identifying Properties

Specify the LDAP properties to use when authenticating users or groupmembers in the
LDAP search.

For User

Optional.When an LDAP user tries to log on, the search-entitled user specified inUser
Entitled to Search LDAP searches the LDAP server entities for that user. When found, the
user is authenticated against LDAP based on one of the user's LDAP properties, by default the
distinguished name. You can use this option to specify another user property to use for
authentication (for example, sAMAccountName or email).

For Group

Optional. By default, the distinguished name is used to identify users in groups. You can use
this setting to specify other properties.

5. Click Next until you arrive at theSummary page. Review the configuration settings, then click
Download to download your settings as configuration file orApply to start the configuration.

How to Map Groups Configured in BVD to Groups Configured on the LDAP Server

1. LDAP must be configured in the BVD configuration wizard as described in "How to Configure the
Connection to the LDAP Server" on page 102.

Make sure theRoot Entry for Group Search settings are configured.

2. Open User Management in BVD:

Administration > User Management

3. Click theManage Groups button and select the group you want to edit or create a new group.
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4. In the properties section of the selected group, search for and assign LDAP groups in theMapped
LDAP groups field as required. When done, save the group.

Note: Although dynamic groups can be selected, they are not supported by BVD and
therefore ignored in groups search.

Download Tools and Samples
BVD provides an extensive set of tools and samples to help you develop dashboards and integrate
data:

Visio Stencil (required)

BusinessValadmueDashboardStencil.zip. Contains the BVD widgets for Visio. Start Visio; in the
Shapeswindow, click More Shapes > Open Stencil and select the extracted BVD stencil file.

You can also save the stencil file toC:\Users\<user name>\My Documents\My Shapes folder
and then access the BVD stencil in Visio inMore Shapes > My Shapes.

Visio Dashboard Template (useful)

Dashboard_Template.zip. Contains a Visio template with an embeddedmacro. Themacro
exports your Visio drawing to SVG each time you save it. The SVG file has the same name as the
Visio drawing and is stored in the same folder.

You can add the BVD template to Visio by specifying the template file name inVisio Options >
Save > Default personal templates location.

Visio Addin (useful)

VisioAddIn.zip. Contains an installer for a Visio ribbon calledDashboard. The buttonExport
Dashboard in the ribbon exports your Visio drawing to an SVG file with the same name and in the
same folder as the drawing itself.

Make sure you have administrative privileges when installing the Visio Addin.

Data Generator Sample (interesting)

samplegen.zip. Contains a VBScript and a batch file to send data to the OMi sample dashboard.
The batch file prompts you for the URL of your data receiver, your API key, and the HTTP proxy and
port.

Sample OMi Status Dashboard (interesting)

omi_sample.zip. Contains the Visio drawing of the OMi sample dashboard. The dashboard is the
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target of the data sent by the data generator VBScript. You can use it as the basis for creating your
ownOMi event and KPI status dashboards.

AO-Bank Sample Dashboards (useful)

ao-bank.zip. Contains the Visio files for the AO-Bank sample dashboards, which you can view at
the BVD demo.

AO-Cellular Sample Dashboards (useful)

ao-cellular.zip. Contains the Visio files for a sample cellular provider.

OMi 10.x Tools (required for the OMi integration)

bvd-omi-tools-10.x.zip. Contains the script/batch files required for integrating event, status,
andmetrics data from OMi 10.x. The tools are included out-of-the-box with OMi 10.10 and later. See
also "OMi 10.11 and later Integration" on page 110.

OMi 09.x Tools (required for the OMi integration)

bvd-omi-tools-09.x.zip. Contains the script/batch files required for integrating event, status,
andmetrics data from OMi 9.x. See also "OMi 10.11 and later Integration" on page 110.
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Data Integration
BVD provides out-of-the-box integrations with HPE Software products such as HPE Operations
Manager i (OMi) and HPE Operations Connector (OpsCx).

However, you can create your own integrations for any data source by writing an adapter for BVD. The
adapter must convert the source data to JSON and send the JSON-enabled data to the BVD data
receiver. Predefined dashboards, which are designed and configured to display the received data, then
complement your integration.

This section includes:

OMi Integration 109

OMi 10.11 and later Integration 110

OMi 10.10 and earlier Integration 112

Operations Connector Integration 125

Custom Integrations 129

Example: Sending JSON Data to BVD 134
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OMi Integration
BVD can be integrated either with OMi 10.10 and earlier versions, or with OMi 10.11 and later versions.

Support matrix

For a list of supported OMi versions including required hotfixes, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Data forwarding

The following OMi data can be forwarded to BVD:

Event Status data: The event status data to be forwarded is collected from anOMi monitoring
dashboard that you specify.

KPI Status data: The KPI status is collected from all CIs that are associated with a view and the KPI
set that you specify.

Metrics data: Themetrics, or Performance Dashboard, data is collected from your graph favorites
(public favorites in 10.12) in OMi.

Version overview

BVD can be integrated either with OMi 10.10 and earlier versions, or with OMi 10.11 and later versions.
You need to follow different integration processes depending on your BVD version.

If you integrated OMi with BVD 10.10 and then upgraded to BVD 10.12, your old integration will not be
valid anymore. Follow the steps described in "OMi 10.11 and later Integration" on the next page to
reenable the data forwarding to BVD.

This section includes:

l "OMi 10.11 and later Integration" on the next page

l "OMi 10.10 and earlier Integration" on page 112
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OMi 10.11 and later Integration

You can configure OMi 10.11 or later versions to send Event Status, KPI Status and Performance
Dashboard data to BVD. Use the BVD Data Forwarding rules manager on the OMi server to specify
which data you want to forward.
To forward Performance Dashboard data, save your performance dashboard charts as favorites with
theShare as Public option enabled before including this data in a rule. For details, see "Enable
Performance Dashboard Data Forwarding on theOMi Server" on the next page.

For information on how to forward this data to BVD, see "Forward OMi Data to BVD" on the next page.

This section includes:

l "BVD Data Channels for OMi Data" below

l "Enable Performance Dashboard Data Forwarding on theOMi Server" on the next page

l "Forward OMi Data to BVD" on the next page

BVD Data Channels for OMi Data

When you send BVD data to OMi by using forwarding rules, BVD creates data channels that uniquely
identify the data you are sending.

Each data channel consists of tags and dimensions (dims). Tags are static labels and dimensions are
names that are associated with a specific value. For more information, see "Custom Integrations" on
page 129.

The data channels are structured differently depending on the data you choose to forward:

Event Status
<tags connected server><tags forwarding rule><dim monitoring dashboard><dim
widget label><dim widget type>

KPI Status
<tags connected server><tags forwarding rule><dim view name><dim CI name><dim
KPI name>

Performance Dashboard
<tags connected server><tags forwarding
rule><metricName><instanceName><dSName><systemName><className>

<tags connected server> are all tags that are specified when adding a BVD Connected Server.
<tags forwarding rule> are all tags that are specified when creating a BVD Data Forwarding Rule.
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Enable Performance Dashboard Data Forwarding on the OMi Server

To enable performance dashboard data forwarding to BVD, follow these steps:

1. In the Performance Perspective, select the charts that you want to forward and save them as
favorites:

a. In OMi, accessWorkspaces > Operations Console > Performance Perspective.

b. In theView Explorer, select a view and then the CI for which you want enable data
forwarding.

c. In thePerformance pane, choose a performance dashboard from the drop-down list.

d. Click the title of the chart you want to save as favorite and click Add to Favorite.

e. Choose to add the favorite to the default page, user-defined favorite page, or create a new
user-defined favorite page. Click Save.

f. Open the favorite in thePerformance pane, access themenu and click Save. Check the
Share as Public option and click Save

Forward OMi Data to BVD

Note: Before you create BVD data forwarding rules in OMi, access Administration > Setup
and Maintenance > Connected Servers to add your BVD instance as a Connected Server.

To forward OMi data to BVD, access Administration > Setup and Maintenance > BVD
Forwarding Rules.

1. In the right pane, click Create. Alternatively, click New.

2. In theGeneral section, complete the following information:

a. Enter a display name and (optional) a description for the forwarding rule.

b. Optional. Enter a comma-separated list of tags.

Data channels can be tagged to separate data from incoming streams and to createmore
specific data channels. For example, if you have separate OMi servers for different regions
and you want separate dashboards for each region, you can add a tag that identifies the region
in which this OMi server is located.

The tags you enter will be added to the data channel after the tags specified for the BVD
Connected Server. For details, see "BVD Data Channels for OMi Data" on the previous page.
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3. In the Target BVD Server section, choose one or multiple Connected Servers from the drop-down
list. This list shows all Connected Servers of the type BVD and Alias. If your BVD connection is
not listed in the drop-down, access Administration > Setup and Maintenance > Connected
Servers to ensure that the server connection was set up correctly.

4. Optional. In theEvent Status section, choose one or multiple monitoring dashboards from which
you want to forward data to BVD.

Caution: If themonitoring dashboard name is changed, the data channel is not updated.
Instead, a new data channel with the changedmonitoring dashboard name is created.
Widgets that use the old data channel in BVD will not receive data from OMi anymore and
need to be updated to the new data channel.

5. Optional. In theKPI Status section, choose the one or multiple views from which you want to

forward KPI status data. Click next to the view name to choose specific KPIs. If no individual

KPIs are selected, KPI status data will be forwarded for all CIs that are associated with the
chosen view.

6. Optional. In thePerformance Dashboard Data section, choose one or multiple public favorites of
your performance dashboards for which you want to forward data to BVD. For information on how
to add performance dashboards as favorites, see "Enable Performance Dashboard Data
Forwarding on theOMi Server" on the previous page.

7. Optional. Clear the check box Activate after save if you want the status of the rule to be inactive
after clickingSave. You can activate the rule at a later point in time.

8. Click Save to save the BVD data forwarding rule.

OMi 10.10 and earlier Integration

You can configure OMi 10.10 or earlier versions to send Event Status, KPI Status andMetrics data to
BVD. Use the bvd-event-status command-line interface on theOMi server to forward event status
data, and the bvd-kpi-status command-line interface to forward KPI status data.
To forwardMetrics data, enable data forwarding in PerformanceGraphing (known as Performance
Dashboard in OMi 10.10), then save your graphs as favorites with the export (or forward) data option
enabled. See "Forward OMi Metrics Data" on page 124.

This section includes:

l "Install and configure the event and KPI status forwarding tools on the OMi server" on the next page

l "Configure and enablemetrics data forwarding on theOMi server" on page 114
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l "Import the BVD certificate to the OMi server" on page 116

Install and configure the event and KPI status forwarding tools on the OMi server

1. OMi versions earlier than 10.10 only. Download and install the BVD-OMi integration tools on the
OMi server. This step is only required for OMi versions earlier than 10.10. The tools are included
out-of-the-box with OMi 10.10 and later.

a. In BVD, download the data forwarding tools for your version of OMi: 10.0x or 9.2x. Go to

Administration > Download Tools & Samples and downloadOMi 10.x Tools orOMi 09.x
Tools.

b. In BVD, open Administration > System Settings, and copy theAPI Key.

This key identifies your BVD instance andmust be included in the data submitted by the data
senders.

Note: The System Settings page is only available to users with administrator privileges.

c. Copy the ZIP file to a temporary directory on the OMi gateway server, and extract it to the OMi
installation directory C:\HPBSM\ or /opt/HP/BSM/.

The following files are placed on your system:

opr/bin/bvd-event-status.bat
opr/bin/bvd-event-status.sh
opr/bin/bvd-kpi-status.bat
opr/bin/bvd-kpi-status.sh
opr/examples/bvd/bvdconf-sample.json
opr/lib/bvd/groovy-all.jar
opr/lib/bvd/bvd-omi-tools.jar

2. Create the subdirectory opr on theOMi server, copy the sample configuration file bvdconf-
sample.json to that directory, and rename it to bvdconf.json:

Windows: %OvDataDir%\shared\server\conf\opr\bvdconf.json

Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

3. Edit the file bvdconf.json and fill in the following information in the OMiEventStatus and
OMiKPIStatus sections:

url Required. URL of the BVD receiver (or the load balancer) including your API
key, which identifies your BVD instance.
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Replace <BVD_URL>with the URL of your BVD receiver:

http(s)://<BVD_server>:<port>

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the
BVD server; <port> is the port assigned to the BVD receiver during the
configuration (default: 12224 or 12225).

Replace <YourApiKey>with your BVD API key from Administration >
System Settings.

dims Required. Comma-separated list of dims. Dims are the fields in the data you
send to BVD, for example, viewName, ciName, and kpiName.

tags Optional. Comma-separated list of tags. Tags enable you to createmore
specific data channels. For example, adding the tags omi,kpi creates the
data channel

omi kpi viewName ciName kpiName.

proxyHost Optional. If your network includes a proxy, insert the FQDN of the proxy
server (for example, myproxy.example.com).

proxyPort Optional. Port of the proxy (for example, 8888).

proxyUser Optional. User account to access the proxy.

proxyPassword Optional. Password of the proxy user account.

Tip: Changing the default dims and tags also requires you to update the data channels that
are configured in the dashboards (for example, in the sample dashboard omi_sample).

Configure and enable metrics data forwarding on the OMi server

1. Prerequisite.Make sure the PerformanceGraphing hotfixes for your version of OMi are installed.
For details, see the support matrix:

Support Matrices for Operations Center products

Download and extract the support matrix files, open the document SUMA.htm and select
Operations Manager i Business Value Dashboard from the product list.

2. In BVD, open Administration > System Settings, and copy theAPI Key.

This key identifies your BVD instance andmust be included in the data submitted by the data
senders.

Note: The System Settings page is only available to users with administrator privileges.

3. Edit the file bvdconf.json file on the OMi gateway server:
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Windows: %OvDataDir%shared\server\conf\opr\bvdconf.json

Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

Tip: If the file does not yet exist, download and extract the OMi data forwarding tools from
BVD. For details, see "Install and configure the event and KPI status forwarding tools on the
OMi server" on page 113.

4. Fill in the following information:

name Required. Replace <YourEndpointName>with the name of the endpoint to
which PerformanceGraphing forwards data, for example, ColorYourData.
This namemust match the endpoint name set in the PerformanceGraphing
infrastructure setting "Endpoint Name" on the next page.

url Required. URL of the BVD receiver including your API key, which identifies
your BVD instance.

Replace <BVD_URL>with the URL of your BVD receiver:

http(s)://<BVD_server>:<port>

<BVD_server> represents the Fully Qualified Domain Name (FQDN) of the
BVD server; <port> is the port assigned to the BVD receiver during the
configuration (default: 12224 or 12225).

Replace <YourApiKey>with your BVD API key from Administration >
System Settings.

tags Optional. Comma-separated list of tags. Tags enable you to createmore
specific data channels. For example, the tags PerformanceGrapher,OMi
create the data channel

PerformanceGrapher OMi metricName instanceName dSName

systemName className.

proxyHost Optional. If your network includes a proxy, insert the FQDN of the proxy
server (for example, myproxy.example.com).

proxyPort Optional. Port of the proxy (for example, 8888).

proxyUser Optional. User account to access the proxy.

proxyPassword Optional. Password of the proxy user account.

5. In OMi, open Infrastructure Settings:

o OMi 9.2x and 10.0x: Admin > Platform > Setup and Maintenance -> Infrastructure
Settings

In theApplications list, select Performance Graphing.
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o OMi 10.10: Administration > Setup and Maintenance > Infrastructure Settings

In theApplications list, select Performance Dashboard.

Configure the following settings:

Endpoint Name Name of the endpoint to which the PerformanceGraphing data is
forwarded. It must match the endpoint name specified in the
bvdconf.json file.

Turn on Data
forwarding to
Endpoint

Set this parameter to true to enable data forwarding from Performance
Graphing to the BVD endpoint.

Default: false

Data Forward
Interval to
Endpoint

Configure the interval (in seconds) at which PerformanceGraphing
forwards the data to the endpoint.

Default: 15 seconds

Data Collection
interval for non-
real time
datasource

Configures the interval (in minutes) at which PerformanceGraphing
collects the data from non-real time data sources. The data collected is
then forwarded to the configured endpoint.

Default: 5 minutes

6. In the Performance Perspective, select themetrics that you want to forward and save them as
favorites. For details, see "Forward OMi Metrics Data" on page 124.

Note: If youmake any subsequent changes to the bvdconf.json file, youmust reset the Turn on
Data forwarding to Endpoint setting in the Infrastructure Settings. To reset, set Turn on Data
forwarding to Endpoint to false and then set it back to true.

Import the BVD certificate to the OMi server

Note: This step is mandatory for OMi 10.10, but applicable for OMi 9.2x and 10.0x only if SSL is
enabled.

Secure the connection to BVD for metrics data forwarding by importing the BVD certificate to the OMi
gateway server.

1. Export the BVD certificate using a web browser, for example Firefox:

a. In the Firefox address bar, click the padlock icon, then click More Information. ThePage
Info page opens at theSecurity tab.

b. In theSecurity tab, click View Certificate.
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Open theDetails tab and click Export. Choose the file name and folder where you want to
save the exported certificate and click Save. The export places the certificate file <file_
name>.crt on your system.

c. Make sure the downloaded certificate is available on the OMi gateway server.

Tip: You can also export the certificate from Internet Explorer if you first installed it in the
browser: Internet Options > Content > Certificates > Export.

2. On theOMi gateway server, import the certificate to the local Java certificate store:

o OMi 9.2x and 10.0x:

<OMi_HOME>/JRE[64]/bin/keytool -import -trustcacerts -keystore <path_to_
keystore> -storepass <password> -alias <alias> -file <path_to_certificate>

Example

%TOPAZ_HOME%\JRE64\bin\keytool.exe -import -trustcacerts -keystore
%TOPAZ_HOME%/JRE64/lib/security/cacerts -storepass changeit -alias
myRootCA -file c:\temp\BVDcert.crt

o OMi 10.10:

<OMi_HOME>/bin/opr-cert-mgmt.[bat|sh] -import <alias> <path_to_certificate>

Example

%TOPAZ_HOME%\bin\opr-cert-mgmt.bat -import -alias myRootCA
c:\temp\BVDcert.crt

3. Verify that the certificate was successfully added to the keystore:

o OMi 9.2x and 10.0x:

<OMi_HOME>/JRE[64]/bin/keytool -list -keystore <path_to_keystore>

Example

%TOPAZ_HOME%\JRE64\bin\keytool.exe -list -keystore %TOPAZ_
HOME%/JRE64/lib/security/cacerts

o OMi 10.10:

<OMi_HOME>/bin/opr-cert-mgmt.[bat|sh] -list
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Example

%TOPAZ_HOME%\bin\opr-cert-mgmt.bat -list

Forward OMi Event Status

Use the bvd-event-status command-line interface to forward event status data from OMi to BVD.

BVD data channels opened up by the bvd-event-status command-line interface:

omi mdb dashboard_name label type

Before you can use the tool, install it as described in "Install and configure the event and KPI status
forwarding tools on the OMi server" on page 113.

Location

<OMi_HOME>/opr/bin/bvd-event-status.[bat|sh]

Synopsis

bvd-event-status <connection> -dashboard_name <Dashboard Name> [-polling_interval
<Polling Interval>] [-dashboard_config <BVD Config File>] -help | -verbose | -
version

Options

Option Description

{-dashboard_
name|-dn}
<Dashboard Name>

Sets the name of the dashboard for which event status data will be collected.

{-polling_
interval|-pi}
<Polling
Interval>

Sets the polling interval (in milliseconds) for collecting event status data.

Default: 10,000milliseconds (10 seconds)

{-dashboard_
config|-dc} <BVD

Sets the path to the BVD configuration file bvdconf.json. If omitted, it
assumes the file in the following directory:
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Option Description

Config File> Windows: %OvDataDir%\shared\server\conf\opr\bvdconf.json

Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

{-post2|-p2} For internal use only.

{-help|-h} Displays a summary of the command options.

{-verbose|-v} Prints verbose output.

-version Displays version information for the tool.

Syntax for <connection>

-username <login name> [ -password <password> | -smartcard | -winCrypto | -jks
<keystore path> -jksPassword <keystore password> ] [[-port <port>] [-server
<gatewayserver>] [-ssl]]

Note: If you do not specify the OMi server to connect to (using the -server option), the command
is executed on the server to which you are logged on.

Option Description

{-username|-user}
<login name>

Sets the login name of the user required to execute CLI operations on
the target gateway server.

{-password|-pw}
<password>

Sets the password for the specified user. If using SSH onCygwin,
either enter the password in free text or use other communication
methods, for example Java keystore, Windows keystore, or smart card
authentication.

Default value: empty string

{-smartcard|-sc} Uses the certificate stored on smart card or security token for
authentication.

{-winCrypto|-wc} If OMi is configured for TLS mutual authentication, this option specifies
to use theWindows certificate store for authentication. The certificate
storemust hold exactly one client certificate, which OMi will use to
authenticate the user. This option is only available onWindows
systems.

{-jks|-j} <keystore
path>

If OMi is configured for TLS mutual authentication, this option can be
used to specify the Java keystore to be used for authentication. The
keystoremust hold exactly one client certificate, which OMi will use to
authenticate the user.
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Option Description

Note: It is not necessary that the client certificate contains the
flag "Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced
Key Usage" field.

{-jksPassword|-jp}
<keystore password>

If OMi is configured for TLS mutual authentication, this option can be
used to specify the Java keystore to be used for authentication. The
keystoremust hold exactly one client certificate, which OMi will use to
authenticate the user.

Note: It is not necessary that the client certificate contains the
flag "Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced
Key Usage" field.

{-port|-p} <port> Uses port <port> to connect to the target gateway server.

Default value of <port>:
80 for HTTP connections
443 for HTTPS connections

-server
<GatewayServer>

Sets the target gateway server, using <GatewayServer> as the
hostname or IP address to locate it.

Default value of <GatewayServer>:
FQDN of the OMi gateway server

-ssl When this option is specified, the HTTPS protocol is used to connect
to the target gateway server. If omitted, the HTTP protocol is used.

Exit Status

Exit
Status Description Output

0 Successful completion of
the requested operation

No output.

1 Failure of the requested
operation

An error message stating why the operation failed,
followed by the tool's help text.

300-399 HTTP Redirection (300-399) An error message stating the HTTP error number and
description.

For more information about HTTP error status values, see
publicly available HTTP documentation.

400-499 HTTP Client Error (400-499)

500-599 HTTP Internal Server Error
(500-599)
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Examples

The following example forwards event status from theOMi monitoring dashboard OMi Health Status
to BVD:

\HPBSM\opr\bin\bvd-event-status.bat -username admin -dashboard_name "OMi Health
Status"

Forward OMi KPI Status

Use the bvd-kpi-status command-line interface to forward KPI status data from OMi to BVD.

Before you can use the tool, install it as described in "Install and configure the event and KPI status
forwarding tools on the OMi server" on page 113.

BVD data channels opened up by the bvd-kpi-status command-line interface:

omi<>kpi<>viewName<>ciName<>kpiName

omi kpi viewName ciName kpiName

Location

<OMi_HOME>/opr/bin/bvd-kpi-status.[bat|sh]

Synopsis

bvd-kpi-status <connection> -view_name <View Name> [-kpi_name <KPI Name>] [-
polling_interval <Polling Interval>] [-dashboard_config <BVD Config File>] -help |
-verbose | -version

Options

Option Description

{-view_name|-vn}
<View Name>

Sets the name of the view for which KPI status data will be collected.
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Option Description

{-kpi_name|-kn}
<KPI Name>

Sets the name of the KPI for which status data will be collected. If omitted,
bvd-kpi-status sends the status of all KPIs for all CIs that are related to the
given view name.

{-polling_
interval|-pi}
<Polling
Interval>

Sets the polling interval (in milliseconds) for collecting event status data.

Default: 10,000milliseconds (10 seconds)

{-dashboard_
config|-dc} <BVD
Config File>

Sets the path to the BVD configuration file bvdconf.json. If omitted, it
assumes the file in the following directory:

Windows: %OvDataDir%\shared\server\conf\opr\bvdconf.json

Linux: /var/opt/OV/shared/server/conf/opr/bvdconf.json

{-post2|-p2} For internal use only.

{-help|-h} Displays a summary of the command options.

{-verbose|-v} Prints verbose output.

-version Displays version information for the tool.

Syntax for <connection>

-username <login name> [ -password <password> | -smartcard | -winCrypto | -jks
<keystore path> -jksPassword <keystore password> ] [[-port <port>] [-server
<gatewayserver>] [-ssl]]

Note: If you do not specify the OMi server to connect to (using the -server option), the command
is executed on the server to which you are logged on.

Option Description

{-username|-user}
<login name>

Sets the login name of the user required to execute CLI operations on
the target gateway server.

{-password|-pw}
<password>

Sets the password for the specified user. If using SSH onCygwin,
either enter the password in free text or use other communication
methods, for example Java keystore, Windows keystore, or smart card
authentication.

Default value: empty string

{-smartcard|-sc} Uses the certificate stored on smart card or security token for
authentication.
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Option Description

{-winCrypto|-wc} If OMi is configured for TLS mutual authentication, this option specifies
to use theWindows certificate store for authentication. The certificate
storemust hold exactly one client certificate, which OMi will use to
authenticate the user. This option is only available onWindows
systems.

{-jks|-j} <keystore
path>

If OMi is configured for TLS mutual authentication, this option can be
used to specify the Java keystore to be used for authentication. The
keystoremust hold exactly one client certificate, which OMi will use to
authenticate the user.

Note: It is not necessary that the client certificate contains the
flag "Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced
Key Usage" field.

{-jksPassword|-jp}
<keystore password>

If OMi is configured for TLS mutual authentication, this option can be
used to specify the Java keystore to be used for authentication. The
keystoremust hold exactly one client certificate, which OMi will use to
authenticate the user.

Note: It is not necessary that the client certificate contains the
flag "Smart Card Logon (1.3.6.1.4.1.311.20.2.2)" in the "Enhanced
Key Usage" field.

{-port|-p} <port> Uses port <port> to connect to the target gateway server.

Default value of <port>:
80 for HTTP connections
443 for HTTPS connections

-server
<GatewayServer>

Sets the target gateway server, using <GatewayServer> as the
hostname or IP address to locate it.

Default value of <GatewayServer>:
FQDN of the OMi gateway server

-ssl When this option is specified, the HTTPS protocol is used to connect
to the target gateway server. If omitted, the HTTP protocol is used.

Exit Status

Exit
Status Description Output

0 Successful completion of
the requested operation

No output.
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Exit
Status Description Output

1 Failure of the requested
operation

An error message stating why the operation failed,
followed by the tool's help text.

300-399 HTTP Redirection (300-399) An error message stating the HTTP error number and
description.

For more information about HTTP error status values, see
publicly available HTTP documentation.

400-499 HTTP Client Error (400-499)

500-599 HTTP Internal Server Error
(500-599)

Examples

The following example forwards KPI status to BVD for all CIs in the view OprSample that have the KPI
Unassigned Events assigned:

\HPBSM\opr\bin\bvd-kpi-status.bat -username admin -view_name OprSample -kpi_name
"Unassigned Events"

Forward OMi Metrics Data

You can configure PerformanceGraphing (known as Performance Dashboard in OMi 10.10 ) to forward
metrics data from OMi to BVD. Themetrics data is collected from your graph favorites in OMi. Your
favorites must be configured to export or forward data to BVD.

Before PerformanceGraphing starts forwarding data, configure and enable data forwarding to BVD as
described in "Configure and enablemetrics data forwarding on theOMi server" on page 114.

BVD data channels opened up by PerformanceGraphing:

metricName instanceName dSName systemName className

Saving charts as favorites for data forwarding

1. In OMi, open thePerformance Perspective:

OMi 9.2x: Applications > Operations Management > Performance Perspective

OMi 10.x:Workspaces > Operations Console > Performance Perspective

2. From theView Explorer, select a view and then the CI for which you want to draw graphs (or
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dashboards). Then save the graphs as favorites with the "export to BVD" option selected as
described below:

o OMi 9.2x and 10.0x:

From theMetrics tab on thePerformance pane, select the data source, themetrics class, the
instance, and themetrics you want to forward. Drag themetrics that you want to see in BVD to
theDrawn Graphs pane.

Click Save as Favorite. In theSave as Favorite dialog box, select Export Data, then click
Save.

o OMi 10.10:

In the Performance pane, click Dashboard Selection and then click the dashboard to
view the dashboard. Click the title of the chart and then click Add to Favorite. In the Favorites
dialog box, you can add the favorite to the default page, user-defined favorite page, or create a
new user-defined favorite page. Then click Save.

Launch the favorite, click the Enable/Disable data forward to BVD button, and then click

Save to save your changes to the favorite.

PerformanceGraphing forwards metrics for all graphs that are saved as favorites and that are
configured to export or forward data to BVD.

Operations Connector Integration
To forward performance data from Operations Connector to BVD, create a Data Forwarding policy in
Operations Connector. The policy must specify your BVD instance as a target and contains rules that
specify which data is sent to BVD.

Learn More

Support matrix

For a list of supported Operations Connector versions, see the support matrix:

Support Matrices for Operations Center products
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Download and extract the support matrix files, open the document SUMA.htm and select Operations
Manager i Business Value Dashboard from the product list.

Tasks

This section includes:

l "Configuring data forwarding in Operations Connector" below

l "Forwarding data using an HTTP proxy" on page 128

l "Forwarding data using HTTPS" on page 129

Configuring data forwarding in Operations Connector

1. In BVD, open Administration > System Settings, and copy theAPI Key.

This key identifies your BVD instance andmust be included in the data submitted by the data
senders.

Note: The System Settings page is only available to users with administrator privileges.

2. In Operations Connector, click Create in the toolbar. Then click Forwarding > Data
Forwarding.

3. In theProperties page, define information that is related to the policy itself (for example, the name
and description of the policy).

4. In the Targets page, set up your BVD instance as a target to which the data is forwarded:

a. In the target list, click New Item above theName column to add a new target.

b. Enter the name of the BVD target and a description.

c. Enter the URL of your BVD data receiver. The URLmust include your API key and
dimensions or tags (or both dimensions and tags) to create unique data channels for your
metrics data:

BVD expects to receive your data as HTTP post requests in JavaScript Object Notation
(JSON) format.

The URL should look something like this:

Installation and Administration Guide
Data Integration

HPE OMi Business Value Dashboard (10.12) Page 126 of 183



http(s)://<BVD_server>:<port>/api/submit/<API_key>/dims/<dims>

<BVD_server>

The Fully Qualified Domain Name (FQDN) of the BVD server.

<port>

The port assigned to the BVD receiver during the configuration. Default: 12224 (HTTP) or
12225 (HTTPS).

<API_key>

Identifies your BVD instance. You can find the API key in Administration > System
Settings.

<dims>

The names in your JSON name-value pairs. Select and combine dims that uniquely
identify your data.

For more information on the URL of the BVD data receiver, see "Sending dimensions and tags
in the receiver URL" on page 130.

Example

You can add the followingmetrics attributes as dimensions to the URL:

dims/dataDomain,relatedCi,name,metricClass,node

This results in the following data channel:

HPBsmIntOEM oem.example.com/oracle_database/oemdb

Average Active Sessions Throughput oem.example.com

For information on themetrics attributes, see the Operations Connector documentation.

d. Select JSON asWire format.

e. Make sureUse Guaranteed Delivery is cleared. If you select this check box, Operations
Connector attempts to resend data that could not be delivered earlier and BVD may receive
outdated data.

5. Configure data forwarding rules:

o To forwardmetrics data after policy rules are applied, select theMetric page and configure
metric data forwarding rules.
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Metric forwarding rules define what a Data Forwarding policy should do in response to specific
metric data. Each rule consists of a condition and of settings for the data generated by the
policy. The settings enable you to configure what data Operations Connector forwards to which
target.

o To forward structured input data, that is, data gathered by a policy before the policy rules are
applied, select theStructured Input page and configure structured input data forwarding rules.

Structured input data rules define what a Data Forwarding policy should do in response to
specific structured input data. Each rule consists of a condition and of settings for the data
generated by the policy. The settings enable you to configure what data Operations Connector
forwards to which target.

Discarding rules have a higher precedence than forwarding rules.

6. Click Save and Close to save the policy and close the editor.

7. Activate the Data Forwarding policy in Operations Connector. Operations Connector starts
sending data to BVD.

In BVD, connect your widgets to the data channels opened up by Operations Connector.

Forwarding data using an HTTP proxy

If you need to redirect the connection from Operations Connector to BVD through an HTTP proxy,
configure the Operations Connector system as follows:

1. Edit the XPL configuration file:

ovconfchg -edit

2. Add the following lines:

[bbc.http]
PROXY=<proxy_hostname>:<proxy_port>+(<included hosts>)-(<excluded hosts>)

Replace <included_hosts>with a comma-separated list of hostnames or IP addresses to which
the proxy enables communication. Replace <excluded hosts>with a comma-separated list of
hostnames or IP addresses to which the proxy cannot connect. Asterisks (*) are wild cards in
hostnames and IP addresses. Both <included_hosts> and <excluded hosts> are optional.

To specify multiple proxies, separate each proxy with a semicolon (;). The first suitable proxy in
the list takes precedence.
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Example

[bbc.http]
PROXY=myproxy.example.com:8888+(mybvd.example.com)

3. Restart the Operations Connector process that forwards the data:

ovc -restart opcgeni

Forwarding data using HTTPS

By default, Operations Connector only trusts the OMi server as certificate authority (CA). For
Operations Connector to trust the CA that issued the BVD certificate, youmust download the root CA
certificates from the BVD CA and import them to Operations Connector trusted root certificate store.

1. Obtain the root CA certificates from the root and any intermediate authorities that issued the BVD
server certificate.

2. On theOperations Connector system, import the certificates to the trusted root certificate store:

ovcert –importtrusted –file <certificate_file>

3. Optional. On theOperations Connector system, run the following command to verify that the trust
has been established:

bbcutil -ping https://<BVD_server>:<port>

Example

bbcutil -ping https://bvdserver.example.com:12225

The following output indicates that the HTTPS connection is successful.

https://<BVD_server>:<port>:
(bbc-288) status=eServiceError coreID= bbcV= appN= appV= conn=0 time=471 ms

eServiceError is normal and indicates that there is no BBC service on the BVD system. If the
output includes eSSLError (or similar), the HTTPS connection was not successful, possibly
because the trust has not been established correctly.

Custom Integrations
BVD expects to receive your data as HTTP post requests in JavaScript Object Notation (JSON)
format.
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It is recommended that your JSON input contains flat data, consisting of name-value pairs. If you need
to send nested data, BVD automatically flattens the data (see also "Nested JSON data" on page 132).
You can also send JSON data in arrays. This enables you to sendmultiple data objects in a single web
service call (see also "JSON data arrays" on page 132).

See also "Example: Sending JSON Data to BVD" on page 134.

Learn More

This section includes:

l "Sending dimensions and tags in the receiver URL" below

l "Sending dims and tags as HTTP parameters" on the next page

l "Sending dims and tags in the receiver URL and as HTTP parameters" on the next page

l "JSON data arrays" on page 132

l "Nested JSON data" on page 132

l "Data storage" on page 133

Sending dimensions and tags in the receiver URL

The BVD receiver URL should look something like this:

l URLwith dimensions only:

http(s)://<BVD_server>:<port>/api/submit/<API key>/dims/<dims>[,<dims=value>]

l URLwith tags only:

http(s)://<BVD_server>:<port>/api/submit/<API key>/tags/<tags>

l URLwith both dimensions and tags:

http(s)://<BVD_server>:<port>/api/submit/<API key>/dims/<dims>[,<dims=value>]
/tags/<tags>

The tags can also precede the dims:

http(s)://<BVD_server>:<port>/api/submit/<API key>/tags/<tags>/dims/<dims>
[,<dims=value>]

<BVD_server>
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The Fully Qualified Domain Name (FQDN) of the BVD server.

<port>

The port assigned to the BVD receiver during the configuration. Default: 12224 (HTTP) or 12225
(HTTPS).

<API_key>

Identifies your BVD instance. You can find the API key in Administration > System Settings.

<tags>

Static labels that you can attach to your data to createmore specific data channels.

<dims>

The names in your JSON name-value pairs. Select and combine dimensions (dims) that uniquely
identify your data.

<dims=value>

The names and values in your JSON name-value pairs. Directly assign values with names to
improve data identification. Use this option, for example, if you have separate servers of the same
data source for different locations and you want separate dashboards for each location. These
name-value pairs do not have to be part of the JSON input. If they are, the values in the JSON input
will be overwritten by the values in the URL.

Sending dims and tags as HTTP parameters

You can also submit the dims and tags as HTTP parameters of the URL.

Example

http://bvd.example.com:12224/api/submit/47a648e9065d465012e541288b5a345e?dims
=viewName,ciName,kpiName,location=nyc&tags=omi,kpi

Sending dims and tags in the receiver URL and as HTTP parameters

You can combine the receiver URL and HTTP parameters to send dims and tags. Define the dims and
tags as part of the URL path first, then add additional dims and tags as HTTP parameters.

Example

http://bvd.example.com:12224/api/submit/47a648e9065d465012e541288b5a345e/dims
/viewName,ciName=abc/tags/omi,kpi?dims=kpiName,location=nyc&tags=bvd

Installation and Administration Guide
Data Integration

HPE OMi Business Value Dashboard (10.12) Page 131 of 183



However, if the same dimension or tag is specifiedmore than once, the value of the last query
parameter overwrites the values of the previous parameters. The value of the last query parameter
appears multiple times as data channel.

Example

http://bvd.example.com:12224/api/submit/47a648e9065d465012e541288b5a345e/dims
/location=boston?dims=location=nyc&tags=east&dims=location=atlanta

In this example, the dim locationwill have the value atlanta. Because dimensions are
accumulated, the value atlanta appears three times as data channel.

JSON data arrays

You can submit multiple JSON objects in a single web service call by adding them to an array.

Array:

[
{

a: 1,
b: 2

},
{

c: 3,
d: 4

}
]

Nested JSON data

If the input contains nested data, BVD automatically flattens the data by renaming nested name-value
pairs to include the names of the parent elements, separated by slashes (/), for example:

Nested JSON data: Flattened JSON data:

{
   a: 1,
   b: 2,
   c: {
      x: 6,
      y: 7
   }
}

{
   a: 1,
   b: 2,
   c/x: 6,

c/y: 7
}
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Data storage

BVD stores only a specific number of data records per channel. The records are only kept if they are
related to a widget. The BVD data aging process scans the database every hour to identify and
automatically delete records that exceed the configuredmaximum number or maximum age. You can
modify the aging defaults; for details, see "Data Aging" on page 165.
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Example: Sending JSON Data to BVD

Sending Data From Data Center East

In this example, Data Center East sends two sets of JSON data to the BVD server. In both sets, the
data fields host and metricName uniquely identify the value. The fields are therefore selected as
dimensions (dims) and included in the URL. Once received by the BVD server, the JSON data
creates two data channels:

Host A CPU load and Host B Disk util.

Lessons learned:Pick the fields in your data that uniquely identify the values you want to
send to BVD and include the fields as dimensions in the HTTP post request.
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Sending Additional Data From Data Center East

The primary location of Data Center East is in New York City, with backup servers located in Boston.
Both locations send the same set of JSON data. To differentiate the data from the two locations
without modifying the JSON data, you can add an additional dimension locwith the corresponding
value to the URL. Themodified URL updates the data channels to

Host A CPU load NYC and Host B Disk util Boston.

In this example, we added the dimension loc to the URL.

Lessons learned:Directly assign values to your dimensions by adding dim=value pairs to
the HTTP post request.
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Sending Data From Data Center West

A second data center, Data CenterWest, starts sending data similar to the JSON data sent by Data
Center East. The data from Data CenterWest uses the same data channels as the data from East.
To distinguish the data from the two centers, you need to add the origin to the data. You can do this
by adding tags to the URL. Tags are static labels that you can attach to your data to createmore
specific data channels.

In this example, we added the tags east and west to the URL. The tags precede the dims in the data
channels.

Lessons learned:Attach tags to your data to create specific data channels.
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Associating Data Channels with Widgets

Once BVD has received the data, it creates the corresponding data channels. You can then
associate a data channel with your widget in the widget's properties. In this example, the data

channel east Host A CPU load NYC has been selected for the sparkline widget.

By default, the widget consumes data from the value data field. In this example, the current value is
42. If the field that holds the values you are interested in has a different name (for example,
metricVal), select that name in the Data Field property of the widget.

Lessons learned:Connect your data to a widget by selecting the corresponding data
channel in the widget's properties.
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Knowledge Base
This section provides more advanced details about configuring BVD. It includes reference information,
procedures, and tips that youmay find useful.

Read this section when you are comfortable with the basic configuration steps, and refer back to it
when necessary. The information in this section is organized as a reference.

Widgets 139

Area andMultiple Area Chart Widgets 140

Bar Chart Widgets 142

Donut Chart Widgets 143

FeedWidgets 144

FrameWidgets 145

Line Chart and SparklineWidgets 146

Status Color Group 147

Status ImageWidgets 147

Status Visible Group 149

Text ValueWidgets 149

Web PageWidgets 150

Widget Properties 150

Chart Autoscale 151

Chart Colors 152

Chart Period 153

Coloring Rule 154

Data Channel 155

Data Field 156

Default Value 157

Donut Size 157

Donut Hole Size 157

FeedMax Items 158

Hyperlink 158
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Image Selection Rule 158

Max Value 159

Min Value 161

MouseOver 161

Number Format 162

Reverse Order of Data Fields 162

Show Chart Numbers 163

Start Angle 163

Status Field 163

Transparent Background 164

URL 164

Visibility Rule 165

Data Aging 165

Tips and Tricks 167

Troubleshooting 171

Widgets
The topics in this section describe all available dashboard widgets. You can create the widgets from
the following BVD shapes in Visio:

You can edit the properties of a widget in Visio (by editing the Shape Data) or in BVD (by editing a
dashboard in Manage Dashboards). We recommend that youmake your changes in BVD because the
dashboard editor simplifies this task by offering values in drop-down lists for you to choose.
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Some advanced operations can only be done in Visio itself. See "Tips and Tricks" on page 167 for
details.

You can upload an SVG file as often as you want. If the file already exists, BVD replaces the previous
version of the file with the newer version and opens the associated dashboard for you to edit. The
newer version does not overwrite existing dashboard properties or widgets, only new widgets are
added.

Rule Operators

Rules use operators to compare current and given values. The available operators are:

== equal

< less than

> greater than

<= less than or equal

>= greater than or equal

!= not equal

Available widgets:

Area andMultiple Area Chart Widgets 140

Bar Chart Widgets 142

Donut Chart Widgets 143

FeedWidgets 144

FrameWidgets 145

Line Chart and SparklineWidgets 146

Status Color Group 147

Status ImageWidgets 147

Status Visible Group 149

Text ValueWidgets 149

Web PageWidgets 150

Area and Multiple Area Chart Widgets

Area charts are used to display quantitative data. They are based on line charts.
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If you have only one set of data to display, use a simpleArea Chartwidget:

To display multiple sets of data, use aMultiple Area Chartwidget:

You can customize the x- and y-axes by changing the font and color in Visio.

See also:

l "Data Channel" on page 155

l "Data Field" on page 156

l "Min Value" on page 161

l "Max Value" on page 159

l "Chart Autoscale" on page 151

l "MouseOver" on page 161

l "Show Chart Numbers" on page 163

l "Chart Colors" on page 152

l "Chart Period" on page 153

l "Number Format" on page 162

l "Visibility Rule" on page 165

l "Hyperlink" on page 158
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Bar Chart Widgets

Use theBar Chartwidget to display a bar chart. Bar charts are useful when you want to compare
multiple values from the same data channel. Each bar in a bar chart corresponds to a field in the data
received over the associated data channel.

TheData Field and theChart Colors properties refer to the bars using a numbering scheme. Bar
number 1 is the leftmost bar with numbering continuing to the right:

For details on how to set the colors of the individual bars, see "Chart Colors" on page 152.

Tomake room for larger labels, you can rotate the bar chart labels in Visio.

TheAngle property in Visio determines the orientation of the label. A default bar chart label has a start
angle of 0 (zero). To rotate the labels, set the angle of the first label to the angle at which you want all
labels to appear. You can do this either by clicking on the label and rotating it or by changing the value
of the label's Angle property:
Access the tab View. Click Task Panes > Size & Position. Click on the first label of the bar chart and
adjust theAngle property.

For example, to rotate the labels of the following bar chart, set the angle of the first label to -45 degrees.
As a result, all other labels will be rotated to the same degree in BVD.

See also:
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l "Data Channel" on page 155

l "Data Field" on page 156

l "Max Value" on page 159

l "Chart Autoscale" on page 151

l "Show Chart Numbers" on page 163

l "Chart Colors" on page 152

l "Number Format" on page 162

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Donut Chart Widgets

Use theDonut Chartwidget to display a donut chart. Each slice in a donut chart corresponds to a field
in the data received over the associated data channel.

TheData Field and theChart Colors properties refer to the donut slices using a numbering scheme.
Slice number 1 is the top right slice with numbering continuing clockwise:

TheStart Angle andDonut Size properties determine the orientation and size of the donut. A default
donut chart has a start angle of 0 (zero) and a size of 360 degrees. To create a partial donut, set the
start angle to the angle at which you want the first slice to appear and specify the size of the donut, also
in degrees.

For example, to create the following gauge-like semicircle donut, set the start angle to 270 and the
donut size to 180. The first slice starts at 270 degrees with the data sources organized clockwise.
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See also:

l "Data Channel" on page 155

l "Data Field" on page 156

l "Start Angle" on page 163

l "Donut Size" on page 157

l "Donut Hole Size" on page 157

l "Max Value" on page 159

l "Reverse Order of Data Fields" on page 162

l "Show Chart Numbers" on page 163

l "Chart Colors" on page 152

l "Number Format" on page 162

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Feed Widgets

The Feedwidget enables you to display information feeds, similar to well-knownRSS feeds. Feeds
must be sent as JSON-encoded data. The data channel must include the fields title and link in order
to display the feed. New feed items are always added to the top of the list.

The Feed widget displays the following items:

l The creation time stamp of the item.

l The title field as text (retrieved from the title data field).

l The link field as hyperlink (retrieved from the link data field).
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Example feed data:

{
   "time":1437633749317,
   "type":"test",
   "title":"Tests show UK Quran manuscript is among world's oldest",
   "link":"http://rss.cnn.com/~r/rss/cnn_latest/~3/HgufPus_pOs/index.html"
}

Note: Do not rotate Feed widgets. This breaks the widget functionality.

You can style the displayed feed items by providing a custom CSS definition in the BVD System
Settings. For more information, see "System Settings" on page 75.

Example

.feedItem .ts {display: none;}

.feedItem .even {background-color: #262627;}

.feedItem a:hover {text-decoration: none;}

.feedItem section {hight:30px; padding: 3px; margin: 0}

See also:

l "Data Channel" on page 155

l "FeedMax Items" on page 158

l "Transparent Background" on page 164

Frame Widgets

BVD offers the following Frame shapes:

l Frame 3:2

l Frame 4:3

l Frame 16:9

The shapes do not have any shape data defined. Their purpose is to help you lay out your dashboards
based on predefined ratios.
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Line Chart and Sparkline Widgets

Use the Line Chartwidget to show a line chart with axes and coordinates:

TheSparklinewidget creates a sparkline chart. Typically, a sparkline is a very small chart, shown
without axes or coordinates:

Tip: Position sparklines next to an absolute number to provide you with a quick reference to the
data trend.

You can change the style of the line in Visio.

See also:

l "Data Channel" on page 155

l "Data Field" on page 156

l "Min Value" on page 161

l "Max Value" on page 159

l "Chart Autoscale" on page 151

l "MouseOver" on page 161
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l "Chart Period" on page 153

l "Number Format" on page 162

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Status Color Group

Group theStatus Color Group shape with other shapes in Visio to make them change color depending
on the values received. You can define the values that cause a color change using the Coloring Rule
property.

Use the group widget when you want to change the color of non-BVD shapes or to color a large number
of shapes. Then it is easier to group the shapes with the Status Color Group and set the coloring rule in
the group widget.

The Status Color Group widget can color the following SVG elements: <path>, <rect>, <ellipse>,
<circle>, and <polygon>.

See also:

l "Data Channel" on page 155

l "Coloring Rule" on page 154

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Status Image Widgets

Use the Status Image widget to display an image depending on the value received for the Status Field
or depending on a rule.

The Status Image shape is a group of shapes. Each shape in the group is an image,
and each image has the shape data Switch Value defined. For example, the "error"
image in the BVD Status Image shape has the Switch Value "red". BVD then
selects the image to display depending on the values received in the data channel.
You can choose the data field to use as input by selecting it in the Status Field
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(default: status), or you can define an image selection rule. For example, if the result of the image
selection rule is "red", the "error" image is displayed.

You can take a look at the Status Image shape in Visio by right-clicking the shape and selectingGroup
> Open Status Image.

Caution: Never ungroup the Status Image shape.

The shape consists of the following four images:

Image Name Switch Value Image

ok green

warning yellow

error red

unknown grey

Do it yourself - Create your own Status Image

1. Make sure Visio is running in developer mode:

File > Options > Advanced > Run in developer mode

2. Drag the BVD Status Image shape to your drawing.

3. Right-click the Status Image shape and select Group > Open Status Image.

You are now inside the shape. You can start editing, deleting, or adding shapes as required.

4. If you add a new shape, youmust add the shape dataSwitch Value to the shape:

a. Right-click the added shape and select Data > Define Shape Data.

b. Add a property with the name opr_switch_value of the type String.

c. Set the value of the property to a value of the Status Field or one that can be selected by an
Image Selection Rule.
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After uploading the exported SVG file to BVD, select the data channel for your Status Image widget.
Then either select a data field for the Status Field property or configure an image selection rule. You
also need to set a default value for situations when no value is available or the value is not one of the
defined switch values.

See also:

l "Data Channel" on page 155

l "Status Field" on page 163

l "Default Value" on page 157

l "Image Selection Rule" on page 158

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Status Visible Group

Group the invisibleStatus Visible Group Visio shape with other shapes to show or hide the widgets
depending on the result of the rule defined in theVisibility Rule property.

Tip: Use the group widget when you want to show or hide non-BVD shapes, or to show or hide a
large number of shapes. Then it is easier to group the shapes with the Status Visible Group and set
the visibility rule in the group widget. You can also set the visibility of a widget based on its
Visibility Rule property. Use this property to show or hide individual widgets.

See also:

l "Data Channel" on page 155

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Text Value Widgets

Use the Text Value widget to display values or to color text. Text attributes like font, alignment, and
rotation are not updated.
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For example, you could use the text value widget to display the current temperature in your store in
New York City. As temperaturemeasurements arrive, the number changes reflecting the current
temperaturemeasured in the store. Additionally, you could configure the text value widget to change
the color of the value displayed depending on the current temperature:

See also:

l "Data Channel" on page 155

l "Data Field" on page 156

l "Number Format" on page 162

l "Coloring Rule" on page 154

l "Visibility Rule" on page 165

l "Hyperlink" on page 158

Web Page Widgets

Web Pagewidgets enable you to show web pages in a dashboard. For example, you can include web
pages that stream television, video, or audio.

The website must be accessible via HTTPS because the BVD UI is also only accessible via HTTPS.
However, if the website sends an X-Frame-Options HTTP header restricting the embedding of this
page to same origin, the browser will not display this web page within the dashboard.

Note: Do not rotateWeb Page widgets. This breaks the widget functionality.

If you use web page widgets in dashboard templates, you can add variables to the URL. Variables will
be replaced by their assigned value when an instance is viewed.

See also:

l "URL" on page 164

Widget Properties
The topics in this section describe all available widget properties.

Chart Autoscale 151
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Chart Colors 152

Chart Period 153

Coloring Rule 154

Data Channel 155

Data Field 156

Default Value 157

Donut Size 157

Donut Hole Size 157

FeedMax Items 158

Hyperlink 158

Image Selection Rule 158

Max Value 159

Min Value 161

MouseOver 161

Number Format 162

Reverse Order of Data Fields 162

Show Chart Numbers 163

Start Angle 163

Status Field 163

Transparent Background 164

URL 164

Visibility Rule 165

Chart Autoscale

Chart Autoscale automatically scales themaximum values and, if available, minimum values.

Bar charts only. If you set Max Value to 0, the bar with the highest value will be shown in full height;
the height of all other bars is shown relative to the highest bar.

Default: not selected
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Examples

The following three sparklines have the same size and show the same data. The scaling,
however, differs because of different min andmax values or Autoscale:

Chart Colors

TheChart Colors property enables you to set colors for your charts. Provide a semicolon-separated
list of RGB color codes in hexadecimal notation.

You can choose the coloring of the first four colors by changing the colors in Visio. However, the colors
you specify in the Chart Colors property override the colors defined in Visio.

If you specify only one color, BVD uses this color for the first data field, and uses the Visio-defined
colors for data fields two to four. If more than four data fields but no colors are defined, BVD randomly
chooses a color for data fields five and higher.

Default: not defined
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Example Donut Chart

The donut chart in the OMi sample dashboard uses the following color codes:

FF0000;FF9933;C8C800;33CC33;B2B2B2

They color the donut chart like this:

Chart Period

Use theChart Period property to set the period of time (in minutes) for which the widget will display
data.

BVD stores only the last 500 data records received from the data senders. To be able to display data,
you need to align the chart period with the rate data is received. For example, if BVD receives one value
per day, themaximum chart period would be 720,000minutes (500 days). If data is received every 15
minutes, themaximum chart period would be 7,500minutes (5.2 days).

Default: 10minutes
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Examples

The following two sparklines have the same size and show the same data. The upper line shows
the data for the last 10minutes, the lower line only the last minute.

Coloring Rule

TheColoring Rule property enables you to determine the color to display depending on the outcome of
a rule.

You can addmultiple coloring rules separated by semicolons:

Rule format: <rule>;<rule>;...

Coloring rules can contain a value only; for example, the value #008000 in a coloring rule colors the
widget green. Rules can also contain conditions that must bematched; for example,
#008000:temperature<60 colors a widget green when the value of the data field temperature is less
than 60.

Rules are evaluated from left to right. When one condition is matched, no additional rules will be
evaluated. If no rule matches, the default is applied; therefore, when you define a set of rules, always
insert the default as the last rule.

Coloring rules have the following format:

<color>[:<property><operator><value>]

<color>
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RGB color code; for example, #000000.

<property>
The name of the data property to use to calculate the color.

<operator>
The operation that is used to compare the current value of the property with the given value. For a
list of operators, see "Rule Operators" on page 140.

<value>
The value the operator works on.

Example

#AABBCC:temperature<60;#7FFF00:temperature<30;#00ff00

If the value of the data field temperature is less than 60, the color #AABBCC is used. If the
value is less than 30, the color #7FFF00 is used. In all other cases, #00ff00 is used as the color.

Data Channel

TheData Channel property enables you to select the data stream over which you want to feed data
into the widget. Before you can select a data stream, youmust send data to BVD, addressed to the
data channel you want to select for your widget.

Example

To show the rise and fall of the temperature in your store in New York City, select the following
data channel for your widget:

The data received includes the following:

type: Temperature
element: Monitor
value: 20.9
status: #008000
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Data Field

Select one or more data fields in the data that BVD received through the data channel to display in your
widget.

Single Data Field

Sparkline, line, and area charts as well as status image and text value widgets support only one data
field.

For single data fields, BVD assumes that the data includes the data field value and uses the values
received for value in the widget.

Default: value

Example Line Chart

The temperature data BVD is receiving from your New York City store already happens to
include the value data field, so you do not need to select it. Otherwise select the data field with
your temperature values.

Multiple Data Fields

Multiple area, bar, and donut charts support multiple data fields. Select a data field for each area, bar, or
slice in the chart. If you select more than four data fields, BVD automatically chooses the colors of the
additional fields. For details, see "Chart Colors" on page 152.

Donut charts only. If you select only one data field for a donut chart, a second one will be automatically
generated based on themax value. For details, see "Max Value in Donut Charts" on page 160.
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Example Donut Chart

The donut chart in the OMi sample dashboard displays the five data fields representing the
number of events per severity, resulting in a donut with five slices:

Default Value

The value set inDefault Value is used when the data in the Status data field is empty or is not one of
the defined switch values. For example, if status: blue or if status: <empty>, then the selected
default value will be used by the Status Image widget.

You can only select one of the switch values defined in the Status Image widget.

The switch values of the BVD default Status Image widget are grey, red, green, and yellow.

Default: grey

Donut Size

TheDonut Size property configures the size of a donut chart within the 360 degrees of the circle of the
donut chart. By default, a donut completes a full circle (360 degrees). To create a gauge-like semicircle,
set the donut size to 180 degrees.

Default: 360

Donut Hole Size

TheDonut Hole Size property configures the size (in percent) of the hole in themiddle of a donut
chart. To create a pie chart, set the donut hole size to 0 percent.

Default: 35
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Feed Max Items

The Feed Max Items property sets themaximum number of items to display in the Feed widget.

Hyperlink

TheHyperlink property enables you to link a widget to another dashboard or to a URL. When a user
then clicks the widget, the linked dashboard or URL opens and replaces the current dashboard in the
browser.

You can add variables from dashboard templates to the URL. Variables will be replaced by their
assigned value when an instance is viewed. Add variables to the URL in the format ${variable}.

For example, a company uses a URL in a dashboard template to show the floor plan of their company
location. They use different instances for each location and want to show the floor plan specific to each
location.

The following URL replaces the query value with the value of the variable location that is assigned to
the instance:

https://example.com/office-locations/floor-plans?site=${location}

When viewing the instance with the assigned value Atlanta, the floor plan for the company location in
Atlanta is shown. The location variable is replaced with Atlanta in the URL:
https://example.com/office-locations/floor-plans?site=Atlanta

If the variable is not defined or the template is converted back into a dashboard, the variable expression
in the URL is not resolved.

For more information on templates and variables, see "TemplateManager" on page 82.

Image Selection Rule

The Image Selection Rule property enables you to determine the image to display depending on the
outcome of a rule.

Note: Image selection rules override the values received for the Status Field.

You can addmultiple rules separated by semicolons:
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Rule format: <rule>;<rule>;...

Rules can contain a value only; for example, the value green in an image selection rule selects the
switch value green. Rules can also contain conditions that must bematched; for example,
green:statusColor==verde selects the switch value greenwhen the value of the data field
statusColor is verde.

Rules are evaluated from left to right. When one condition is matched, no additional rules will be
evaluated. If no rule matches, the default is applied; therefore, when you define a set of rules, always
insert the default as the last rule.

Image selection rules have the following format:

<switch value>[:<property><operator><value>]

<switch value>
Switch value assigned to an image in the Status Image shape. The switch values of the default
Status Image shape are green, yellow, red, and grey.

<property>
The name of the data property to use to calculate the color.

<operator>
The operation that is used to compare the current value of the property with the given value. For a
list of operators, see "Rule Operators" on page 140.

<value>
The value the operator works on.

Example

green:statusColor==verde;yellow:statusColor==amarillo;red:statusColor==rojo;g
rey

If the value of the data field statusColor is verde, the image with the switch value green is
selected. The value amarillo selects the image yellow, rojo selects red, and the image grey
is displayed in all other cases.

Max Value

Max Value in Bar Charts

SetMax Value to set themaximum value the chart should display.

Default: 100
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Max Value in Donut Charts

SetMax Value to set amaximum value for the chart. Setting theMax Value property is only relevant
for donut charts with only one data field. If two or more fields are selected, Max Value is disabled.

Default: 100

Example Donut Chart

If the current value of the data field is 30 andMax Value is set to 100, the donut chart will display
two slices: one slice with the value 30 and the other slice with the value 70.

Max Value in Line, Sparkline, Area, and Multiple Area Charts

Line, sparkline, area, andmultiple area charts have amin and amax value property. Set Min Value and
Max Value to adjust the range of data displayed in the chart. Data outside this range is cut from the
chart.

If Chart Autoscale is used, themin andmax values are ignored.

Default: 100

Examples

The following three sparklines have the same size and show the same data. The scaling,
however, differs because of different min andmax values or Autoscale:
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Min Value

SetMin Value andMax Value to adjust the range of data displayed in the chart. Data outside this
range is cut from the chart. If Chart Autoscale is used, themin andmax values are ignored.

Default: 0

Examples

The following three sparklines have the same size and show the same data. The scaling,
however, differs because of different min andmax values or Autoscale:

Mouse Over

TheMouse Over property enables you to enable or disable themouse over tooltip. The tooltip offers
detailed information on the current data point. The indicator and the tooltip font can be customized in
Visio.

Default: selected
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Number Format

Use theNumber Format property to format or manipulate the values displayed below the charts.

Number format works as documented here: http://numeraljs.com/

Number format respects the current locale for formatting.

Example

'$0,0.00'

This example changes the number 1000.234 to the string $1,000.23.

Reverse Order of Data Fields

Use theReverse Order of Data Fields property to change the display order of the donut slices (or data
fields) from clockwise to counterclockwise. This property is useful when your donut chart starts at an
angle contrary to the natural reading direction.

For example, to create the following gauge-like semicircle donut, set the start angle to 90 and the donut
size to 180. The first slice starts at 90 degrees with the data sources organized clockwise. To change
the order of the slices to counterclockwise, click theReverse the Display Order of the Data Fields
check box in the donut widget properties.

Default: not selected
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Show Chart Numbers

TheShow Chart Numbers property has the following effect:

l Bar and donut charts. Shows or hides the numbers.

You can customize the formatting of the numbers (for example, change color or font) by reformatting
the number "1" in Visio.

l Line, area, and multiple area charts. Shows or hides x- and y-axes. See also "Showing or hiding
x- and y-axes" on page 168.

You can customize the x- and y-axes by changing the font and color in Visio.

Default: selected

Tip: Use theNumber Format property to format or manipulate the values.

Start Angle

TheStart Angle property determines the location of the first slice in a donut chart. By default, the first
slice (or data field) starts at 0 (zero) degrees within the 360 degrees of the circle of the donut chart.

Default: 0 (zero)

Status Field

TheStatus Field property enables you to select a data field in the received data that contains a switch
value for the Status Image widget.

By default, BVD assumes that the data includes the data field status and uses the values received for
status to update the color.

Note: Image selection rules override the values received for the Status Field.

Default value: status (providing switch values)
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Example

The temperature data BVD is receiving from your New York City store already happens to
include the status data field, so you do not need to select it. Otherwise select the data field that
contains your switch values.

Transparent Background

Select Transparent Background to hide the placeholder shape and show the feed as a transparent
overlay.

URL

Specifies theURL of the web page you want to show in this widget.

Example

https://softwaresupport.hpe.com/group/softwaresupport/search-result?keyword=

You can add variables from dashboard templates to the URL. Variables will be replaced by their
assigned value when an instance is viewed. Add variables to the URL in the format ${variable}.

For example, a company uses a URL in a dashboard template to show the floor plan of their company
location. They use different instances for each location and want to show the floor plan specific to each
location.

The following URL replaces the query value with the value of the variable location that is assigned to
the instance:

https://example.com/office-locations/floor-plans?site=${location}
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When viewing the instance with the assigned value Atlanta, the floor plan for the company location in
Atlanta is shown. The location variable is replaced with Atlanta in the URL:
https://example.com/office-locations/floor-plans?site=Atlanta

If the variable is not defined or the template is converted back into a dashboard, the variable expression
in the URL is not resolved.

For more information on templates and variables, see "TemplateManager" on page 82.

Visibility Rule

TheVisibility Rule property enables you show or hide the widget based on the outcome of a rule.

Tip: You can also use the Status Visible Group widget to show or hide a widget. Use the group
widget when you want to show or hide non-BVD shapes, or to show or hide a large number of
shapes. Then it is easier to group the shapes with the Status Visible Group and set the visibility
rule in the group widget. See also "Status Visible Group" on page 149.

Visibility rules have the following format:

<property><operator><value>

<property>
The name of the data property to use to calculate the visibility.

<operator>
The operation that is used to compare the current value of the property with the given value. For a
list of operators, see "Rule Operators" on page 140.

<value>
The value the operator works on.

Example

errors>=10

If the value of the data field errors is greater than or equal to ten, the widget is shown in the
dashboard. In all other cases, the widget is hidden.

Data Aging
By default, up to 500 data records per data channel are stored in the database. The controller process
scans the database every hour to identify and automatically delete records that exceed the configured
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maximum. You canmodify the aging defaults as follows:

1. Start the configuration wizard by running the following command:

Windows: <BVD_Install_Dir>\BVD\bin\configure.bat

Linux: /opt/HP/BVD/bin/configure.sh

2. In a browser, enter the URL:
http://localhost:5000

Note: localhost:5000 uses the default port 5000. If this port is already in use, follow the
instructions displayed in the command line to identify the correct URL.

3. Enter the password for the configuration wizard and click Submit.

4. Navigate to the stepAging and complete the following settings:

Scanning Interval (in minutes)

Time interval (in minutes) at which the aging process scans the database to identify and
automatically delete data records.

The valuemust be an integer greater than 0.

Default: 60minutes

Data Records

Purge old data records based on their age, their maximum number, or both.

Maximum Age

Time period (in days) during which data records are kept in the database. Records older than
the configured time period are automatically deleted by the aging process.

The valuemust be an integer greater than 0.

Default: 100 days

Maximum Number

Maximum number of data records stored in the database per data channel. If this number is
exceeded, the oldest records are deleted by the aging process.

The valuemust be an integer greater than 0.

Default: 500

Data Channel Statistics
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Time period (in days) during which a data channel is available in the list of data channels in the
widget properties. If a data channel does not receive any data during the configured time period
and the data channel is not associated with a widget, it is deleted from the data store. If the
data channel is associated with a widget, the channel is not deleted even if the data last
received for the channel is older than the configured time period.

The valuemust be an integer greater than 0.

Default: 1 day

5. Click Next until you arrive at theSummary page. Review the configuration settings, then click
Download to download your settings as configuration file orApply to start the configuration.

Tips and Tricks
This section includes:

l "Font usage" below

l "Exporting Visio drawings to SVG" on the next page

l "Showing or hiding x- and y-axes" on the next page

l "Displaying small fonts in Firefox" on the next page

l "Displaying horizontal or vertical lines with gradient line color" on the next page

l "Showing widget tooltips even if the widget is overlaid by another shape" on page 169

l "Inserting Twitter feeds in a dashboard" on page 170

l "Linking dashboards" on page 171

l "Improving loading time of dashboards with raster graphics" on page 171

Font usage

For BVD to be able to render the text as designed in Visio, youmust make the fonts used in Visio
available to the web browser where you view the dashboards. If the web browser does not have access
to the fonts, the system default fonts are used.

For example, if you use theWindows font Calibri in Visio, and then view your dashboard in a browser
on a Linux system, the browser will substitute Calibri with a Linux system font because Calibri is not
installed.
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To enable platform-independent text rendering, useGoogle Fonts when designing your dashboard
drawings in Visio. BVD then directs the browser to load the fonts from http://www.google.com/fonts
when displaying a BVD dashboard.

You can also use custom fonts but youmust set up a publicly accessible web server that serves the
fonts and specify a CSS definition for your custom font in the System Settings page. See "Use Custom
Fonts in Your Dashboards" on page 76 for details.

Exporting Visio drawings to SVG

When you save a Visio drawing as an SVG file make sure that the following settings are selected:

l Save as type: Scalable Vector Graphics (*.svg)

l Select: Include Visio data in the files

l Tip: Press Ctrl+A to select everything in the drawing. This ensures that your entire drawing is
exported and not the currently selected element only.

Alternatively, click theExport Dashboard button in theDashboard ribbon, if you have installed the
BVD Visio Addin.

Showing or hiding x- and y-axes

Line, area, andmultiple area charts by default show x- and y-axes. You can hide the axes by clearing
theShow Chart Numbers check box in the widget properties.

The availability of the check box is controlled by the Visio shape dataShow Chart Numbers, which is
by default set to TRUE. If you change this to FALSE and then re-import the exported SVG file, the
check box is removed from the widget properties. To re-enable the check box, change the setting to
TRUE in Visio and re-import the drawing to BVD.

Displaying small fonts in Firefox

Firefox displays small fonts in SVGs larger than their intended size. To work around this problem, make
the original SVG file bigger and let the browser scale it down.

Displaying horizontal or vertical lines with gradient line color

SVG files do not display horizontal or vertical lines with gradient line color. The lines need to deviate
from being horizontal or vertical.
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Showing widget tooltips even if the widget is overlaid by another shape

Note: To add data to a shape, Visio must be running in developer mode: File > Options >
Advanced > Run in developer mode.

If you have placed a Visio shape on top of a BVD shape, you can configure the obscuring shape to
display the BVD tooltips by adding the shape data opr_no_mouse_action:

Set the value of opr_no_mouse_action to TRUE. This makes the obscuring shape transparent to the
mouse and enables the BVD widget to display tooltips onmouse over.
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Inserting Twitter feeds in a dashboard

Although the name suggests it, Twitter feeds cannot be inserted directly in a dashboard using the Feed
widget. You would first need to convert the tweets to JSON format and then send the converted tweets
to BVD.

The steps below describe an alternativemethod to include tweets using theWeb Page widget:

1. Prerequisite. You need a web server that is configured to serve HTML files and allows the
inclusion of its pages into the BVD page (X-Frame-Option HTTP Header).

2. Place an HTML file with the following content on the web server:

<html>
   <head>
      <style>
         iframe {
                height: 100%;
                }
      </style>
</head>
<body style="margin:0">
</body>

3. Place the HTML snippet provided by Twitter between the body tags of the HTML file.

4. Add aWeb Page widget to your dashboard and set its URL property to the URL of the page
located on your web server. For details, see "Web PageWidgets" on page 150.
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Linking dashboards

You can link dashboards by inserting any widget and selecting the target dashboard in theHyperlink
property. When a user clicks the widget, the linked dashboard opens and replaces the current
dashboard in the browser.

If the link should be a simple button, without status updates, use the Text Value widget as follows:

1. Insert a Text Value widget in your Visio drawing, change the default text "Value" to what will be
your link, and style the widget as desired. Export the drawing to SVG and then upload the SVG file
to BVD.

2. In BVD, edit the Text Value widget:

a. Do not select aData Channel. This will cause an error, which you can ignore.

b. Use theHyperlink drop-down list to select the dashboard you want to link to.

3. Save your changes to the dashboard. Then view the dashboard and test the link.

For details, see "Text ValueWidgets" on page 149.

Improving loading time of dashboards with raster graphics

Raster graphics images in dashboards increase the size and therefore the loading time of the
dashboards. To reduce the size of the images, compress them in Visio before saving your drawing to
SVG. In Visio, select the image, then click Format > Compress Picture. Increasing the compression
reduces the file size but also the quality of the image.

Troubleshooting
This section includes:

l "Installation log files" on the next page

l "Configuration and runtime log files" on page 173

l "Enabling access logs" on page 174

l "Enabling debug logs" on page 175

l "Managing BVD processes" on page 175

l "Clearing user locks " on page 176
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l "Browser limitations" on page 176

l "Verifyingmetrics forwarding from OMi to BVD" on page 177

l "Notificationmessages" on page 178

l "Install and Configure" on page 181

l "Dashboards and Templates" on page 182

Installation log files

The following log file contains the logs of the overall installation process:

Windows: %TEMP%\HPEBVD_<version>_HPOvInstaller.txt

Linux: /tmp/HPEBVD_<version>_HPOvInstaller.txt

For log files of the individual packages, see the following directory:

Windows: %TEMP%\HPOvInstaller\HPEBVD_<version>

Linux: /tmp/HPOvInstaller/HPEBVD_<version>
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Configuration and runtime log files

BVD keeps log files to help you troubleshoot the application. You can view log files with any text editor.
Most log files are located in the following directory:

Windows: <BVD_Data_Dir>\BVD\log\

Linux: /var/opt/HP/BVD/log/

access.log

Log file containing access information of the BVD web server. This log file is only available if
access logging is enabled. See also "Enabling access logs" on the next page.

controller.log

Log file of the BVD controller.

audit.log

Log file containing audit logs for successful and failed user logins. See also "Logging Into BVD" on
page 9.

configserver.log

Log file of the BVD configuration process. This file also contains the information from the
configure.log file. See also "Configuration" on page 36.

configure.log

Log file of the BVD silent configuration process. See also "Silent Configuration" on page 49.

pgsql.log

Log file of the BVD embedded PostgreSQL database.

receiver.log

Log file of the BVD data receiver.

receiver-access.log

Log file containing access information of the BVD receiver. This log file is only available if access
logging is enabled. See also "Enabling access logs" on the next page.

redis.log

Log file of the BVD embedded Redis in-memory database.

sentinel.log
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Log file of the sentinels that monitor the processes of the Redis database and define themaster
Redis.

web-server.log

Log file of the BVD web server.

Enabling access logs

Access logs contain information about all requests processed by the server (for example HTML files or
graphics). This data can then be statistically analyzed and summarized by another program.

You can enable access logging for the BVD receiver and/or web server. To enable access logging in
BVD, complete the following steps:

Caution: Enabling access logging for the receiver will also log the API keys. This might impact
the security of BVD as every user with access to the log files will be able to see the API keys.

1. Edit the startReceiver.js and/or startWebServer.js JavaScript file:

Windows: <BVD_Install_Dir>\BVD\dashboard\scripts\*.js

Linux: /opt/HP/BVD/dashboard/scripts/*.js

2. Change the line
process.env.DEBUG = 'bvd:error:*';
to
process.env.DEBUG = 'bvd:error:*,bvd:accessLog';

3. Restart the corresponding BVD process.

This will log all BVD receiver requests to receiver-access.log and all BVD web server requests to
access.log.
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Enabling debug logs

In debugmode, BVD records more detailed output in its log files. To enable debugging, complete the
following steps for each process that you want to debug. You can enable debugging for the BVD aging,
receiver, and web server processes.

1. Edit the JavaScript file for the process that you want to debug:

Windows: <BVD_Install_Dir>\BVD\dashboard\scripts\*.js

Linux: /opt/HP/BVD/dashboard/scripts/*.js

2. Remove the two slashes (//) at the beginning of the following line:

//process.env.DEBUG='bvd:*';

3. Restart the processes, for example:

ovc -restart bvdaging bvdrc bvdws

Managing BVD processes

The following BVD processes must be running for BVD to operate successfully:

bvdcontroller BVD Controller BVD (3512) Running
bvdpg BVD Postgres DB BVD (3256) Running
bvdrc BVD Receiver BVD (1228) Running
bvdredis BVD Redis Server BVD (2196) Running
bvdsentinel BVD Redis Sentinel BVD (3484) Running
bvdws BVD Web Server BVD (2804) Running

The BVD processes are registered with the OV Control service, which is an HPE L-Core Component
and included in the shared content installed with BVD. Use the ovc command-line interface tomanage
the BVD processes:

l Status. To check whether the processes are running, type ovc -status.

l Stop, start, and restart. You can stop, start, and restart the processes by using the -stop, -
start, and -restart options.

l Help. Formore information on ovc, type ovc -help.

Tip: On Linux, ovc may not by default be included in the PATH variable. To add the path to the
shared content to the PATH variable, type:

export PATH=/opt/OV/bin:$PATH
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Clearing user locks

BVD locks out users if the number of failed login attempts exceeds the Login Attempts Allowed,
specified during the configuration. The lock clears after the Lock Out Time is up (also specified during
the configuration). To clear the lock manually, restart the BVD web server:

ovc -restart bvdws

Browser limitations

l Internet Explorer only:Uploading a dashboard locks the SVG file on disk

In Internet Explorer 10 or 11 browsers, the upload of SVG files locks the files in the file system. For
example, after uploading an SVG file in Internet Explorer, when you then click Apply orSave in the
Manage Dashboards page and try to re-export to the file from Visio, the Visio changes are not saved
to the SVG file.

This is a known problem in Internet Explorer 10 and 11:
https://connect.microsoft.com/IE/feedback/details/817183/ie10-and-ie11-keep-files-locked-after-
uploading

Workaround:After saving the uploaded dashboard, refresh theManage Dashboards page, for
example by pressing F5.

l Chrome only: It is not possible to download a dashboard that includes a picture

In Chrome browsers, downloading a dashboard from theAdministration > Manage Dashboards
page is not working. This affects dashboards that include images of more than 2MB.

Workaround:Chrome has a limitation of 2MB for data URI downloads:
https://code.google.com/p/chromium/issues/detail?id=44820
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Verifying metrics forwarding from OMi to BVD

Metrics Forwarding from Performance Graphing in OMi 9.2x and 10.0x:

1. In OMi, open Infrastructure Settings:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

In theApplications list, select Performance Graphing.

2. Set the option Trace Level to 2.

3. Access the ovpmtrace.0.txt file available at the following location:

Windows: %ovdatadir%\shared\server\log

Linux: /var/opt/OV/shared/server/log

4. The log file contains tracemessages that indicate that PerformanceGraphing is forwarding the
data to the endpoint.

The following are samples from the log file:

com.hp.pm.core.configuration.PostDataTask:run() -> JSON data to post ...
com.hp.pm.core.configuration.PostDataTask:postDashboardData() -> Post data to
service dashboard endpoint is success

Metrics Forwarding from Performance Dashboard in OMi 10.1x:

1. In OMi, open Infrastructure Settings:

Administration > Setup and Maintenance > Infrastructure Settings

In theApplications list, select Performance Dashboard.

2. Access the bvd.log file available at the following location:

Windows: <OMi_HOME>\log\pmi

Linux: /opt/HP/BSM/log/pmi

3. The log file contains tracemessages that indicate that Performance Dashboard is forwarding the
data to the endpoint.

The following are samples (trace level set to INFO) from the log file:

com.hp.pm.core.configuration.bvd.PostDataTask:postDashboardData()
-> BVD - Post data to endpoint is success
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Notification messages

BVD displays notificationmessages if there are issues with the created dashboards. The following
sections describe themessages and solutions.

The data received from the server does not contain {0} but {1} values

Widgets: Bar Chart, Donut Chart

The chart is configured to display {0} values. However, the data sent by the server only contains {1}
values. Check the data sent by the server andmake sure that it contains all required data fields. Open

Administration > Manage Dashboards to verify the configured data fields and the data sent by
the server in the data channel selector.

There is no valid data channel set

Widgets: Bar Chart, Status Color Group, Donut Chart, Feed, Status Images, Sparkline / Multiple Area
Chart, Text Value, Status Visibility Group

There is no data channel set for this widget. Therefore it will not receive any data to display. Open

Administration > Manage Dashboards to configure a data channel for the widget.

There are no 'path' or 'rect' elements for the dashboard item '{0}'

Widgets: Status Color Group

The Status Color Group is coloring lines and areas of the grouped shapes. If these do not contain lines
and areas, coloring will fail with this error. Open the dashboard in Visio andmake sure that valid shapes
are grouped with this Status Color Group.

The property '{0}' used in the coloring rule is not part of the data. Please check the

syntax of the rule. (Dashboard item '{1}')

Widgets: All widgets with coloring/image selection rules

Open Administration > Manage Dashboards and verify the rule's syntax: the rule should only use
data fields that are included in the data sent by the server.
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The coloring rule '{0}' is not valid. Please check the syntax of the rule. (Dashboard

item '{1}')

Widgets: All widgets with coloring/image selection rules

Open Administration > Manage Dashboards and verify that the rule adheres to the format
described in "Coloring Rule" on page 154.

The data received from the server is missing either the 'link' or the 'title' field (Feed '

{0}')

Widgets: Feed

Make sure that the data sent by the server contains the data fields “link” and “title”.

The data received from the server does not contain a status (Status images '{0}')

Widgets: Status Image

The status field configured in Administration> Manage Dashboards is not part of the data sent by
the server. Make sure that the server sends the correct data or the correct status field is chosen.

The data received from the server does not contain a property called '{0}' (Spark

line '{1}')

Widgets: Sparkline / Multiple Area Chart

The data field configured in Administration> Manage Dashboards is not part of the data sent by
the server. Make sure that the server sends the correct data or the correct data field is chosen.

There is no valid URL for the dashboard item '{0}'

Widgets: Web Page

There is no URL set for this widget. Therefore it will not display any data. Open Administration>
Manage Dashboards to configure a URL for the dashboard item.
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The property '{0}' used in the visibility rule is not part of the data. Please check the

syntax of the rule. (Dashboard item '{1}')

Widgets: All widgets with visibility rules

Open Administration> Manage Dashboards and verify the rule's syntax: the rule should only use
data fields that are included in the data sent by the server.

The visibility rule '{0}' is not valid. Please check the syntax of the rule. (Dashboard

item '{1}')

Widgets: All widgets with visibility rules

Open Administration> Manage Dashboards and verify that the rule adheres to the format
described in "Visibility Rule" on page 165.

Unable to calculate a color with the data received from the server (Dashboard item '

{0}')

Widgets: All widgets with coloring rules

The value sent by the server, together with the provided coloring rule, did not result in a color. Open

Administration> Manage Dashboards to verify the accuracy of your coloring rule and provide a
default color as the last entry. For details on defining coloring rules, see "Coloring Rule" on page 154.
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Install and Configure

Investigate installation issues by accessing the installation log file. For details, see "Installation log
files" on page 172.

Investigate configuration issues by accessing the configuration log files. For details, see "Configuration
and runtime log files" on page 173.

Linux Only: Unzip error during installation

Description

The BVD installation requires unzip to be installed on the system. If unzip is not installed, the
installation will fail with a corresponding error message.

Solution

Onmost Linux systems, unzip and zip utilities are not installed by default. Tomanually install unzip,
run the following command:

yum install unzip

Linux Only: Configuration fails with error "Unable to register and start BVD"

Description

During the configuration, the error "Unable to register and start BVD" is shown. BVD cannot be
configured successfully.

Solution

Run ovc -status to see which processes are running. If the process bvdws is running, but not bvdrc,
run the following commands:

ovc -kill
ovc -start
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Dashboards and Templates

Find solutions and workarounds for dashboard or template limitations that are not covered by the
notificationmessages. For details, see "Notificationmessages" on page 178.

Only parts of a dashboard are zoomed

Description

When you zoom in and out of a dashboard, only parts of the dashboard are zoomed. The Visio source
file of the dashboard contains backgrounds, titles, or borders from the Visio Designmenu, which
prevent BVD from correctly zooming the dashboard.

Solution

Towork around this problem, do not use Visio backgrounds, titles, or borders. Instead, place a suitable
shape in the background and style it accordingly; use a text shape for the title.

Visio produces blank SVG files or shapes are missing in the export

Description

When editing a dashboard in Visio, the dashboard is blank or shapes aremissing after it is exported as
SVG file.

Solution

Visio supports styles for shapes which the SVG standard does not. Having applied one of these styles
to a shape can lead tomissing shapes or empty dashboards after exporting to SVG. This happens, for
example, to all shapes with shadows.

Remove the unsupported style or review theMicrosoft Visio documentation for possible workarounds.
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation and Administration Guide (OMi Business Value Dashboard 10.12)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to ovdoc-asm@hpe.com.

We appreciate your feedback!

Go OMi!

mailto:ovdoc-asm@hpe.com?subject=Feedback on Installation and Administration Guide (OMi Business Value Dashboard 10.12)
https://hpln.hpe.com/group/operations-manager-i-omi
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